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Customer Support

Technical Assistance
To search our knowledge base for a solution or to log in to the Technical Support 
portal and report a problem, go to www.hsmcontactsupport.com.

For our latest contact information, see www.honeywellaidc.com/locations.

Product Service and Repair
Honeywell International Inc. provides service for all of its products through service 
centers throughout the world.  To find your service center, go to 
www.honeywellaidc.com and select Support.  Contact your service enter to obtain a 
Return Material Authorization number (RMA #) before you return the product.

To obtain warranty or non-warranty service, return your product to Honeywell  
(postage paid) with a copy of the dated purchase record.

Limited Warranty
For warranty information, go to www.honeywellaidc.com and click Get Resources > 
Product Warranty.

Send Feedback
Your feedback is crucial to the continual improvement of our documentation. To 
provide feedback about this manual, contact the Honeywell Technical Communi-
cations department at ACSHSMTechnicalCommunications@honeywell.com.
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CHAPTER

1

PX4i and PX6i Hi
USING THE PRINTER
Learning About the Printers
The PX4i and PX6i High Performance printers are rugged, 
high-volume, thermal transfer printers. With sturdy, all-metal construction, these 
printers are designed to excel at 24/7 printing in harsh industrial environments 
and easily adapt to changes in host environments or applications.

The PX4i and PX6i support a maximum print width of four or six inches, respec-
tively. Throughout this manual, both models of the printer are referred to as 
“printer” unless otherwise noted.

Identifying the Parts of the Printer
Use this section to familiarize yourself with the parts of the printers.

Front View

Media cover

LEDs

Screen 

Keypad

Front door

Print 
mechanism

Connector
for optional
cutter 
gh Performance Printer User Guide 1



Back View

Selecting a Printer Language
Your printer comes loaded with different printer command languages. The first 
time you start your printer, you are prompted to select the command language. The 
printer language you choose affects the functionality of the printer and how you 
interact with it.  

Printer Start Up Screen
Press the key that corresponds to the printer language you want to run on your 
printer.

On/Off switch

AC Power cord socket

CompactFlash (CF) card slot

Machine label

RS-232 serial interface 

Provision for IEEE parallel
interface board 

USB interface

Intake slot for external
media supply

Intake slot for external
media supply

Wireless antenna 
connector (option)

USB host port

Ethernet interface

Printer Language Description

Fingerprint Fingerprint is a BASIC-inspired programming language you use to design 
label formats and write custom printer application software.

Printer Language 
(IPL)

IPL is an easy-to-use programming language that lets you design, 
download, and modify formats.

ZSim ZSim is a Zebra™ interpreter program that interprets ZPL II or later 
programs. To setup, configure, and use ZSim, see the ZSim Programmer’s 
Guide.

DSim DSim is a Datamax™ simulation program that runs Datamax programs. To 
setup, configure, and use DSim, see the DSim Programmer’s Guide.
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This screen appears the first time you turn on your printer. The language you select 
automatically runs each time you turn on your printer.

Once your printer is running a particular printer language, you can change the 
printer language from the Setup menu. The way that you access the command lan-
guage menu depends on which language you are currently running.

Understanding the Control Panel
The control panel provides buttons, LEDs, and a liquid crystal display (LCD) for you 
to interact with the printer. 

Use this illustration to familiarize yourself with the buttons and lights on the 
printer.

Language How to Access the Command Language Menu

IPL Go to SETUP > TEST/SERVICE > CMD LANGUAGE.

Fingerprint or 
Direct Protocol

Go to SETUP > PRINT DEFS > CMD LANGUAGE.

ZSim or DSim Step 1. Press .

Step 2. Enter the Fingerprint password: 8311.

Step 3. Press .
Step 4. Go to SETUP > PRINT DEFS > CMD LANGUAGE.

F1=FP, F2=IPL

F3=ZSIM, F4=DSIM
Pause Setup

Feed

F3

F5

F2

F4

F1

Shift

1 2 3

4 5 6

7 8 9

0 Clear

Enter

./-

Status

Setup

Enter

Pause Setup

Feed

F3

F5

F2

F4

F1

Shift

1 2 3

4 5 6

7 8 9

0 Clear

Enter

./-

Status
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Understanding the Buttons
Use the buttons and button combinations to perform functions on the printer. If 
you are using Fingerprint applications, you can assign custom functions to each 
button or disable individual buttons. For help, see the Fingerprint Developer’s 
Guide.

Understanding the LEDs
The printer has three LEDs: Power, Status, and the Ready-to-Work® indicator.

Button 
Name

Button Description

Print Feeds or pauses a print job. Reprints the last printed label

Pause Pauses and resumes printing.

Pause + 
Shift  + 

Stops a Fingerprint application.

Setup Enters Setup mode. 

Feed Feeds a blank label or other media type.

Feed + Shift
 + 

Performs a Testfeed (feeds a blank label and adjusts the media 
feed).

i Displays error messages, Ready-to-Work status, and 
communication channel information.

< >
 or After you press , use these buttons to scroll through error 

and information messages.

Pause

Pause Shift

Setup

Feed

Feed Shift

LED State Description

Power Solid green Power is on.

Status Solid green The printer is ready.

Blinking 
green

The printer is communicating.

Solid red There is a printer error. For more information, see "Troubleshooting 
the Printer" on page 87.

Ready-to-
Work 
Indicator

Off The Ready-to-Work Indicator is off when the printer:

• is in Setup mode (you pressed  on the keypad).

• is in Information mode (you pressed  on the keypad).

• firmware is being upgraded.

Solid blue The printer is powered on and operating.

Setup
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Understanding the Screen
The screen provides background illumination and displays two lines of text, each 
with 16 characters. The screen displays error messages, as well as useful informa-
tion when you start, setup, and upgrade your printer.

The Fingerprint programming language and Direct Protocol allow custom-made 
messages to be composed and displayed according to the requirements of the 
application.

Understanding the Printer Sounds
The printer plays sounds in response to certain actions. The sounds that are played 
depend on which version of firmware you are running:

If you are running IPL:

• the printer beeps when you press a button. 

• the printer beeps continuously if the printer is out of media or ribbon. 

• you can use an IPL command to create an audio alarm. For help, see the 
Printer Language (IPL) Developer’s Guide.

If you are running Fingerprint:

• the printer beeps when you press a button. You can also use a Fingerprint 
command to turn off this beep.

• the printer beeps when an error occurs.

• you can use Fingerprint commands to specify the frequency and duration of 
beeps for different conditions or even make the printer play simple melodies. 
For help, see the Fingerprint Developer’s Guide.

Loading Media
The PX4i and PX6i can print on labels, tickets, tags, and continuous stock in vari-
ous forms. The method you use to load media depends on how you want the printer 
to operate. The PX4i and PX6i can print in these modes:

• Tear-off (straight-through)

• Peel-off (self-strip)

Blinking blue A blinking light indicates one of these conditions:

• The printer is initializing.

• The printer is waiting for external resources.

• There is a printer error that requires you to perform an action. 
For more information, see "Troubleshooting the Printer" on 
page 87.

LED State Description
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• Cut-off

• Batch take-up

• External supply

• RFID

If you are using Fingerprint, use the  key to load the same type of media. If you 
change the media type, or if the printer does not feed the media properly, simulta-

neously press the  and  keys to perform a “testfeed.”

If you are using IPL, save the label with the sensitivity number attached to the 
media roll. You need this number to set the media sensitivity.

Loading Media for Tear-Off Printing
In tear-off, or straight-through, printing mode, you manually tear off the media 
against the printer’s tear bar. In tear-off mode, use these types of media: 

• Non-adhesive continuous stock

• Self-adhesive continuous stock with liner

• Self-adhesive labels with liner

• Tickets with gaps (gap stock), with or without perforations

• Tickets with black marks (mark stock), with or without perforations

You can also install an optional label taken sensor so that the next  copy in the 
batch is not printed until the current copy is removed. For more information, see 
"Accessories for the Printer" on page 124.

If you are running Fingerprint, use the  key to load the same type of media. If 
you switch to a new type of media, or if the printer does not feed out the media 

properly, simultaneously press the  and  keys to perform a “testfeed.”

If you are running IPL, save the label indicating the sensitivity number attached to 
the media roll. You need this number to set the media sensitivity.

To load media for tear-off printing
1. Turn off the printer.

Feed

Shift Feed

Feed

Shift Feed
6 PX4i and PX6i High Performance Printer User Guide



2. Open the front door and media cover.

3. (PX6i only) Pull the locking handle down.

f
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4. Raise the printhead by turning the printhead lift lever counter-clockwise.

5. If necessary, remove the empty core from the media supply roll post.
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6. If you are using a media roll with a 76 mm (3 in) core, install a 3-inch adapter on 
the media supply hub.

7. Fit a new roll of media on the supply post and push the roll in as far as it will go.
PX4i and PX6i High Performance Printer User Guide 9



8. Route the media under the slack absorber and forward toward the print 
mechanism. The slack absorber can be routed for better access and then snap-
locked in open position.

 

9. Route the media through the print unit and push it in as far as it will go.

Route the Media
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Media Path

10. Lower the printhead by turning the printhead lift lever clockwise.

11. (PX6i only) Push the locking handle up.
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12. Adjust the position of the green edge guides so that the media is guided with a 
minimum of play.

13. Close the front door and media cover. Make sure that the media runs through 
the slot in the front door.

14. Press  to advance the media and adjust the media feed. Tear off the media 
by grabbing the outer edge and pulling it downwards.

Loading Media for Peel-Off Printing
In peel-off, or self-strip mode, self-adhesive labels are separated from the liner 
immediately after printing. Peel-off printing:

• can only be used for self-adhesive labels with liner.

• requires the optional peel-off assembly.

• cannot be performed with the optional fanfold guide installed.

• sets high demands on the media, such as label stiffness, release characteristics 
of the adhesive and liner, and resistance against electrostatic charging. Consult 

Feed
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your media supplier or test the media to make sure that it is suitable for your 
application.

• may limit registration performance when printing on labels that have a label 
length of less than 25 mm (1 in).

You can also install an optional label taken sensor so that the next  copy in the 
batch is not printed until the current copy is removed. For more information, see 
"Accessories for the Printer" on page 124.

To load media for peel-off printing
1. Turn off the printer.

2. Open the front door and media cover.

3. (PX6i only) Pull the locking handle down.

f
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4. Raise the printhead by turning the printhead lift lever counter-clockwise.

5. Pull out the green clip on the liner takeup hub and dispose of any wound-up 
liner.

6. Remove any empty core from the media supply hub.
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7. If your are using a media roll with a 76 mm (3 in) core, fit an adapter on the 
media supply hub.

8. Fit a new roll of media onto the media supply hub and push the roll in as far as it 
will go.
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9. Route the media under the slack absorber and forward toward the print 
mechanism. The slack absorber can be rotated for better access and then snap-
locked in open position.

10. Route the media through the print unit and push it in as far as it will go.
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11. Pull out approximately 40 cm (15 in) of labels and remove the labels from the 
liner.

12. Route the liner around the tear bar and back under the print unit.

40 cm/15 in
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13. Secure the liner to the takeup hub with the green clip and rotate the hub until 
the media is pulled tight.

Secure the Liner

Media Path
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14. Turn the printhead lift lever clockwise to lower the printhead.

15. (PX6i only) Push the locking handle up.
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16. Adjust the position of the green edge guides so that the media is guided with a 
minimum of play.

17. Close the front door and media cover.

18. Press  to advance the media and adjust the media feed.

Loading Media for Cut-Off Printing
You can install the automatic paper cutter option to cut off the media. Cut-off 
printing can be used for non-adhesive continuous stock and self-adhesive labels 
with liner (cut only liner between labels). The cutter option:

• is designed for paper-based media with a thickness between 60 and 175 µm, 
roughly corresponding to a paper weight of 60 to 175 grams/m2 (basis weight 
40 to 120 lb). 

• cuts through the media approximately 37 mm (1.5 in) in front of the printer’s dot 
line. Make sure to properly adjust the media feed. For help, see "Configuring the 
Printer" on page 63.

Feed
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• should not be used to cut through labels, because the adhesive sticks to the 
shears, which can damage the cutter. If you do cut through adhesive labels, tilt 
the cutter down and clean it with isopropyl alcohol.

• must be enabled in Setup mode. For help, see "Configuring Your Printer From the 
Screen" on page 63.

• is held by a latch inside the media compartment and can be tilted forward to 
facilitate loading media. 

• has a switch that prevents it from operating when it is in the open position. 

• can be fitted with an optional tray for collecting cutoff labels.

• requires the front door to be removed.

You can also install an optional label taken sensor so that the next  copy in the 
batch is not printed until the current copy is removed. For more information, see 
"Accessories for the Printer" on page 124.

To load media for cut-off printing
1. Turn off the printer.

2. Open the cutter and media cover.

Warning:  The cutting edge rotates when you turn on the power and 
reboot the printer. Always keep the cutter in the closed position 
during operation. Turn off the power or disconnect the cutter 
before cleaning. Keep your fingers away from cutting edges.
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3. (PX6i only) Pull the locking handle down.

4. Turn the printhead lift lever counter-clockwise to raise the printhead.
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5. Remove any empty core from the media supply hub.

6. If your are using a media roll with a 76 mm (3 in) core, fit an adapter on the 
media supply hub.
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7. Fit a new roll of media onto the media supply hub and push the roll in as far as it 
will go.

8. Route the media under the slack absorber and forward toward the print 
mechanism. The slack absorber can be rotated for better access and then snap-
locked in open position.
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9. Route the media through the print unit and push it in as far as it will go.

Route the Media

Media Path
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10. Turn the printhead lift lever clockwise to lower the printhead.

11. (PX6i only) Push the locking handle up.
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12. Adjust the position of the green edge guides so that the media is guided with a 
minimum of play.

13. Route the media through the cutter between the two guide plates.
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14. Close the cutter while pulling on the end of the media. 

15. Close the media cover and then turn on the power. 

16. Press  to advance the media and adjust the media feed.

Loading Media for Internal Batch Takeup Printing
In batch takeup mode, printed labels fitted on liner (backing paper) or pre-perfo-
rated tickets and tags are wound up inside the printer. The roll of printed labels, 
tickets, or tags can then be removed. 

Batch takeup printing requires the optional factory-installed internal liner/batch 
takeup accessory. The takeup hub can accommodate 30 to 40% of a full-size 
media roll.

Internal batch takeup can be used for these types of media:

• Self-adhesive labels fitted on liner

• Pre-perforated tickets with gaps

• Pre-perforated tickets with marks

To load media for internal batch takeup printing
1. Turn off the printer.

Feed
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2. Open the front door and media cover.

3. Turn the printhead lift lever counter-clockwise to raise the printhead.

4. Remove any empty core from the media supply hub.
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5. Loosen the single screw that holds the guide plate at the rear of the media 
compartment.

6. Remove the tear bar from the print unit and replace it with the guide plate.
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7. If you are using a media roll with a 76 mm (3 in) core, fit an adapter on the 
media supply hub.

8. Fit a new roll of media onto the media supply hub and push the roll in as far as it 
will go.
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9. Route the media under the slack absorber and forward toward the print 
mechanism. The slack absorber can be rotated for better access and then snap-
locked in open position.

10. Route the media through the print unit and push it in as far as it will go.
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11. Pull out approximately 40 cm (15 in) of labels.

12. Route the labels around the guide plate and back under the print unit to the 
takeup hub.

40 cm/15 in
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13. Wind up some of the media on the takeup hub and secure it with the green clip.

Winding and Securing the Media

Media Path
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14. Turn the printhead lift lever clockwise to lower the printhead.

15. Adjust the position of the green edge guides so that the media is guided with a 
minimum of play.

16. Close the media cover, but keep the front door open.
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17. Press  to advance the media and adjust the media feed.

Loading Media for Printing From an External Supply
You can place the media supply, such as fanfold tickets or tags, behind the printer. 
The external supply can be used with these printing methods:

• Tear-off (straight-through)

• Cut-off

• Peel-off (upper slot only)

• Internal batch takeup

It is strongly recommended using the fanfold guide accessory. This guide makes 
loading media easier and accurately guides the media. The fanfold guide can be 
adjusted for various media widths down to 40 mm (1.57 in).

Note: Make sure to protect the media from dust, dirt, or other foreign particles that can 
impair the printout quality or cause unnecessary wear to the printhead. 

Feed
36 PX4i and PX6i High Performance Printer User Guide



To load media for printing from an external supply
1. (Optional) Fit the fanfold guides in either the upper or lower slot. The outer 

guide is adjustable for various media widths. The minimum width is 40 mm 
(1.58 in).

• Fit the fanfold guide into the upper slot in the rear plate when the supply is at the 
same level as the printer or in peel-off mode.

• Fit the fanfold guide into the lower slot in the rear plate when the supply is 
placed lower than the printer.

2. Feed the media through the slot in the rear plate.

Feeding Media Through the Upper Slot
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Feeding Media Through the Lower Slot

Loading Ribbon
The printer can perform direct thermal printing on special heat-sensitive media or 
thermal transfer printing on special ink-coated ribbon. The printer can use transfer 
ribbon rolls wound with the ink-coated side facing either outward or inward. 

Thermal transfer printing lets you use a wide range of receiving face materials and 
provides a durable printout that is less vulnerable to external influences, such as 
oil, chemicals, heat, and sunlight than direct thermal printing. Make sure to select 
ribbon that matches the type of receiving face material and set up the printer 
accordingly.

To load ribbon for thermal transfer printing
1. Open the front door and media cover.
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2. (PX6i only) Pull the locking handle down.

f

3. Turn the printhead lift lever counter-clockwise to raise the printhead.
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4. Remove any unused ribbon and the empty ribbon core.

5. Adjust the ribbon supply bobbin for your ribbon.

• If your ribbon is 55 to 60 mm (2.16 to 2.3 in) wide, compress the ribbon 
supply bobbin and move it so it snaps into the first (innermost) groove.

EasyCoder  PX4i

55-60 mm
(2.1-2.3”)
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• If your ribbon is 88 to 90 mm (3.5 in) wide, compress the ribbon supply 
bobbin and move it so it snaps into the second groove.

• If your ribbon is 110 mm (4.3 in) wide, compress the ribbon supply bobbin 
and move it so it snaps into the third (outermost) groove.

80-90 mm
(3.5”)

110 mm
(4.3”)
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6. Press the ribbon roll onto the ribbon supply bobbin and route the ribbon 
through the print unit. Pull out 20 cm (8 in) of ribbon.

7. Without releasing the ribbon, turn the printhead lift lever clockwise to lower the 
printhead and lock the ribbon.
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8. Press the cardboard core at the front end of the ribbon onto the rewind hub. 
During printing, the rewind hub rotates counter-clockwise.

9. Turn the printhead lift lever counter-clockwise to raise the printhead.
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10. Wind up the ribbon until all of the transparent leader has passed the printhead 
and the ribbon becomes tight.

11. Turn the printhead lift lever clockwise to lower the printhead.
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12. Close the front door and media cover.

13. Set the Paper Type to Thermal Transfer Ribbon (TTR).

• On your printer’s keypad, press  to enter the Setup menu.

• If you are using Fingerprint, go to Media > Paper Type > Transfer.

• If you are using IPL, go to Media > Paper Type > TTR.

• Press .

• Press  to exit the Setup menu.

Printing a Test Label
You can print a test label (perform a testprint) to:

• make sure that your printer is working properly.

• get your printer’s setup, hardware, and network information.

• get RFID tag information.

• check print quality and determine which adjustments to make.

To perform a testprint

1. Press  to enter the Setup menu, and use the keypad to go to the TESTPRINT 
menu:

• If you are running Fingerprint, go to SETUP > PRINT DEFS > TESTPRINT.

• If you are running IPL, go to SETUP > TEST/SERVICE > TESTPRINT > 
CONFIG.

2. Select a testprint to perform. For more information, see the next tables.

Setup

Enter

Setup

Setup
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Fingerprint Testprint Options

IPL Testprint Options

Testprint Description

Diamonds Prints a diamond pattern.

Chess Prints a chess board pattern.

Bar Codes #1 Prints a horizontal set of bar codes.

Bar Codes #2 Prints a vertical set of bar codes.

Setup Info Contains current configuration parameters stored in the printer’s memory, defined 
pages, defined formats, defined graphics, defined fonts, and any installed printer 
options.

Hardware Info Contains printer memory information; printer mileage; printhead settings; 
firmware checksum, program, and version number.

RFID Test 
Label

Prints an RFID test label that includes the tag type name.

Network Info Contains WINS name, MAC address, IP selection, IP address, netmask, default 
router, name server, mail server, primary WINS server, secondary WINS server, and 
network statistics.

Testprint Description

Config

SW Contains current configuration parameters stored in the printer’s memory, 
defined pages, defined formats, defined graphics, defined fonts, and any 
installed printer options.

HW Contains printer memory information; printer mileage; printhead settings; 
firmware checksum, program, and version number.

Network Contains WINS name, MAC address, IP selection, IP address, netmask, 
default router, name server, mail server, primary WINS server, secondary 
WINS server, and network statistics.

RFID Test Label Prints an RFID test label that includes the tag type name.

Test Labels

Pitch Contains an even pattern of small dots that reveals failing printhead dots 
and variations of printout darkness due to uneven printhead pressure or bad 
energy regulation to the printhead.

Print Quality Contains bar codes with different characteristics and useful information 
about the printer model, program version, print speed, and media sensitivity 
setup.

Format

All > Print 
Formats

Contains a single format that you can use to evaluate the print quality of a 
particular format. This option prints labels for all the formats stored in the 
printer’s memory.

Page
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Creating and Printing Labels
The easiest way to create and print labels is to use the label design software 
LabelShop®. You can download it from the Downloads page for your printer on the 
Honeywell website at www.honeywellaidc.com.

You can also use Fingerprint and IPL to create and print labels. For more informa-
tion, see the Fingerprint Command Reference Manual or the IPL Command Refer-
ence Manual. 

Printing on RFID Media
Media containing RFID tags is slightly thicker where the RFID tag is located. The 
slight thickness of this part of the label may affect print quality. For thermal trans-
fer labels, use a high-quality ink ribbon, such as TMX 2304 or TMX 1500.

To achieve the best possible print quality, follow these guidelines:

• After you load RFID media, restart the printer or run a TESTFEED to let the 
printer identify the RFID media type.

• If necessary, modify the TAGADJUST variable to make sure that the RFID labels 
are properly aligned with the antenna. 

• If necessary, avoid printing on the thickest part of the label.

• For printers running Fingerprint:

• If you are using thermal transfer labels, start with the ribbon constant set to 
80 and the ribbon factor set to 25. You may need to adjust these values 
depending on the type of media you choose.

• To write to Gen 2 RFID tags using the TAGFIELD command, set the start and 
length parameters to even numbers.

• For printers running IPL:

• Start with the sensitivity set to 565. You may need to adjust this value 
depending on the type of media you choose.

All > Print 
Pages

Tests the ability of the printer to receive and print single or multiple pages of 
label data that is sent from the host. This option prints labels for all the 
pages stored in the printer’s memory.

UDC

All > Print UDC Tests the ability of the printer to receive and print single or multiple user-
defined characters (bitmap graphics) that are sent from the host. This option 
prints labels for all the UDCs stored in the printer’s memory.

Font Contains all the characters in a single font. This option prints labels for all 
the user-defined fonts (UDF) stored in the printer’s memory.

Testprint Description
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• To write to Gen 2 RFID tags, set the start and length parameters of the RFID 
tag field setup command (a) to even numbers.

For help configuring RFID parameters, see the Fingerprint Command Reference 
Manual or the IPL Command Reference Manual.
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CHAPTER

2

PX4i and PX6i Hi
CONNECTING THE PRINTER
Connecting the Printer to Your PC
You can easily connect the printer to your PC using one of these ports:

• RS-232 serial port

• USB device port

• IEEE 1284 communications port (optional)

Connecting the Printer to a PC Through the Serial Port
You can use a serial connection to communicate with your PC and run PrintSet, 
LabelShop, or Honeywell print driver. You can also use the serial port to send com-
mands directly to the printer through a terminal connection, for instance with Tel-
net.

Before you can establish a serial connection, make sure that the settings on the PC 
match those of your printer.

Parameter Default Setting

Baud rate 9600

Data bits (IPL) or Character length (Fingerprint) 8

Parity None

Stop bits 1

RTS/CTS (Fingerprint only) Disable

ENQ/ACK (Fingerprint only) Disable

XON/XOFF, data to host (Fingerprint only) Disable

XON/XOFF, data from host (Fingerprint only) Disable

New line (Fingerprint only) CR/LF

Receive buffer (Fingerprint only) 1024 bytes

Transmit buffer (Fingerprint only) 1024 bytes
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To connect the printer to a PC through the serial port
1. Connect one end of the RS-232 cable that ships with your printer to the back of 

the printer and connect the other end of the cable to a serial COM port on the 
PC.

2. If necessary, change the PC serial port configuration to match your printer.

Connecting the Printer to a PC Through the USB Device Port
Note: You cannot communicate with the printer using PrintSet through a USB connection. 

To use PrintSet, you must be connected serially or through the Ethernet or 802.11 
network.

Only connect one printer to each PC, either directly, or through a hub. To connect 
the printer to a PC through the USB device port, you need:

• a USB Type B to USB Type A cable.

• Honeywell Print Driver software, which is available on the Honeywell website at 
www.honeywellaidc.com.

To connect the printer to a PC through the USB port
1. Download and install the Honeywell Print Driver software on your PC.

2. Connect the USB cable to the Type B connector on the back of the printer and 
connect the other end to your PC.

You do not need to set up any parameters for USB communications.

Connecting the Printer to a PC Through the IEEE 1284 Port
You can use the parallel connection with LabelShop or Honeywell Print Driver. The 
parallel port supports Universal Plug and Play (UPnP) and additional status 
reporting through IEEE 1284 nibble ID mode. 

If you are using a parallel port to communicate with the printer, you need:

• an IEEE 1284 interface adapter installed in the printer. If you do not have the 
parallel interface installed in your printer, you can purchase the field 
installable option and have it installed by an authorized Honeywell service 
technician. For help, contact your representative.

• a parallel cable to run between the printer and the PC.

To connect your printer to a PC parallel port
Connect the IEEE 1284 cable connector to the interface adapter port on the back 
of the printer and connect the other end of the cable into a parallel port on the PC.
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Connecting the Printer to Your Network
You can connect your printer to your network using the:

• integrated Ethernet interface.

• optional 802.11 wireless interface.

These network interfaces provide features such as security, FTP server, web server, 
and Alert handling.

Setting Up Ethernet Communications
Use the Ethernet port to set up the PX4i or PX6i as a network printer. If Ethernet is 
selected as your Network Type, when you turn on your printer, it automatically 
retrieves an IP address from the network (DHCP+BOOTP). You can use the network 
connection with LabelShop or the Honeywell Printer Driver. You can also use this 
connection to send commands directly to the printer through a terminal connec-
tion (Telnet) or FTP. 

To connect your printer to your Ethernet network
1. Make sure that Ethernet is selected as your Network Type. 

• On the keypad, press  to enter the Setup menu.

• Go to SETUP > NETWORK > NETWORK TYPE > ETHERNET.

• Press  again to exit the Setup menu.

2. Connect the cable from your Ethernet network to the Ethernet port on your 
printer’s back plate.

3. Turn your printer off and then on.

4. Enter Information mode by pressing the  button. The printer displays 
interface information in five-second intervals. Note the IP address displayed 
under I/O net1.

5. On your PC, start your web browser.

Setup

Setup
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6. Enter the IP address of your printer in the address field and press Enter. Your 
printer home page appears.

7. When you are prompted, enter your login and password. The default values are: 
login = admin, password = pass.

For help using the printer web page to configure your printer, see "Configuring Your 
Printer From the Printer Home Page" on page 64.

If your network does not automatically assign an IP address, or the Ready-to-Work 
indicator is blinking to indicate a network error, you can use PrintSet (available to 
download from www.honeywellaidc.com) to correct the network settings.

Manually Configuring IP Settings
You can configure the IP settings of your printer by sending Fingerprint or IPL 
commands through a serial connection. After you configure the IP settings, you 
can disconnect the printer from your PC and communicate with the printer using 
Ethernet communications.

To configure the IP settings serially using Fingerprint
Note: You need to have administrator privileges to configure IP settings.

1. Connect the printer to your PC using a serial cable. For help, see "Connecting 
the Printer to a PC Through the Serial Port" on page 49.

2. Send the following commands to permanently assign the IP address, subnet 
mask, default router, and name server:
setup "network,IP selection,manual"
setup "network,IP address,xxx.xxx.xxx.xxx"
setup "network,netmask,xxx.xxx.xxx.xxx"
setup "network,default router,xxx.xxx.xxx.xxx"
setup "network,nameserver,xxx.xxx.xxx.xxx"
where xxx is a number from 0 to 255.

3. Disconnect the printer from the PC.
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4. On your PC, enter the IP address of the printer in the address field of your web 
browser (for example http://10.200.27.94) and press Enter.

The home page of the printer appears.

To configure the IP settings serially using IPL
1. Connect the printer to your PC using a serial cable. For help, see "Connecting 

the Printer to a PC Through the Serial Port" on page 49.

2. Send the following commands to permanently assign the IP address, subnet 
mask, default router, and name server:

<SI>nn[,m1[,m2]]
where:

• n is the IP address of the printer in the format n.n.n.n, where n is a number 
from 0 to 255.

• ,m1 is the subnet mask address in the format n.n.n.n, where n is a number 
from 0 to 255.

• ,m2 is the router address in the format n.n.n.n, where n is a number from 0 to 
255.

Note: You must specify at least two of the three parameters for the command to take effect.

3. Disconnect the printer from the PC.

4. On your PC, enter the IP address of the printer in the address field of your web 
browser (for example http://10.200.27.94) and press Enter.

The home page of the printer appears.

Setting Up 802.11 Radio Communications
If your printer has an optional 802.11 b/g radio, you can transfer and receive data 
using wireless communications. This manual assumes that you have already set 
up your wireless communications network including your access points. This sec-
tion describes how to set up wireless security on your printer.

The printer supports these authentication modes: 

• none

• WEP (64 bit and 128 bit)

• WPA Personal and Enterprise mode (802.1x authentication)

• WPA2 Personal and Enterprise mode (802.1x authentication)

Note: WPA and WPA2 Enterprise mode currently support PEAP, TTLS, LEAP, and EAP-
FAST. For LEAP authentication, the printer supports Open EAP, but does not support 
Network EAP.
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To set up the printer to work in your wireless network, you need:

• a serial cable.

• a PC running Windows or Linux.

• PrintSet. For the latest version of PrintSet, go to the Downloads page of the 
Honeywell website at www.honeywellaidc.com.

• (optional) Serial port software such as HyperTerminal. If you are using IPL 
commands with HyperTerminal, you may want to be able to see the commands 
as you type them on your screen. For help, see "Configuring Your Printer With 
Commands Sent From Your PC" on page 80.

To set up the printer for 802.11 communications using PrintSet
1. Download and install PrintSet on your PC.

2. Connect one end of the serial cable to your printer, and connect the other end to 
your PC.

3. If necessary, change the serial port settings on your PC to match your printer:

4. On your PC, start PrintSet.

5. In the General Tasks box, click Add Printer.

6. Step through the Add Printer Wizard until you have successfully added your 
printer.

7. In the Printer Tasks box, click Wireless Setup Wizard.

8. Step through the Wireless Setup Wizard to set up wireless network and security 
parameters.

To set up the printer for 802.11 communications using HyperTerminal
1. Connect one end of the serial cable to your printer, and connect the other end to 

your PC.

Parameter Default Setting

Baud Rate 9600

Data Bits 8

Parity None

Stop Bits 1
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2. On your PC, open HyperTerminal and set these serial port parameters:

3. From the host PC, check the wireless settings. For help, see "Manually 
Configuring IP Settings" on page 52.

• If you are running IPL, send this command to the printer:
<STX><SI>wt<ETX>

• If you are running Fingerprint, send these commands to the printer:
setup write "wlan","uart1:"
setup write "8021x","uart1:"

4. Configure your printer to use the correct SSID and authentication modes. For 
help, see the next section, "Configuring 802.11 Wireless Security Using IPL" on 
page 58 or "Configuring 802.11 Wireless Security Using Fingerprint" on 
page 55.

5. If you are using certificates for validation, test first without the certificate. Only 
after performing this test should you transfer the certificate to the printer. The 
printer can accept PEM (.pem), DER (.der), and PKCS #12 (.p12 or .pfx) 
certificates.

6. Verify that the printer is connected to the access point and make sure it has an 
IP address allocated to it.

Use the following sections to set most of your wireless communication settings. 
For more information, see the Fingerprint Command Reference Manual or the IPL 
Command Reference Manual. 

Configuring 802.11 Wireless Security Using Fingerprint
Use the following procedures to configure 802.11 wireless security parameters on 
your printer using Fingerprint.

To configure the printer to use WEP authentication

1. Send the following commands to login as an admin and set the SSID:
run "su -p pass admin"
setup write "wlan","uart1:"
setup "wlan","SSID","xxxxx"
where xxxxx can be from 0 to 32 ASCII characters, not including 

the double quote.

Parameter Default Setting

Baud Rate 9600

Data Bits 8

Parity None

Stop Bits 1
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To enter non-alphanumeric octets, use “%nn,” where nn is two hexadecimal digits 
representing the value of the character.

Note: The default password for logging in as an admin is “pass.” If you have changed the 
password, you will need to use your password instead of “pass.”

2. Send the following commands to configure the WEP keys. The following 
example sets WEP key 1 to 01234 and enables WEP key 1.
setup "wlan","WEP1","0x3031323334"
setup "wlan",".WEP_KEY","1"
setup "wlan","ACTIVE","1"
setup write "wlan","uart1:"

To configure the printer to use WPA-PSK or WPA2-PSK mode

1. Send the following commands to login as an admin and set the SSID:
run"su-p pass admin"
setup write "wlan","uart1:"
setup "wlan","SSID","xxxxx"
where xxxxx can be from 0 to 32 alphanumeric characters.

To enter non-alphanumeric octets, use “%nn,” where nn is two hexadecimal digits 
representing the value of the character.

Note: The default password for logging in as an admin is “pass.” If you have changed the 
password, you will need to use your password instead of “pass.”

2. Send one of the following WPA/WPA2 ON commands to turn on WPA or WPA2 
authentication. Send the WPA-PSK or WPA2-PSK command to set a pre-shared 
key:
setup "wlan","WPA","OFF"
setup "wlan","WPA2","ON"
setup "wlan","WPA_PSK","xxxxxxxxxx"
setup "wlan","ACTIVE","1"
setup write "wlan","uart1:"
where xxxxxxxxxx is a value between 8 and 64 characters.

To configure the printer to use WPA or WPA2 Enterprise mode

1. Send the following commands to login as an admin and set the SSID:
run"su-p pass admin"
setup write "wlan","uart1:"
setup "wlan","SSID","xxxxx"
where xxxxx can be from 0 to 32 alphanumeric characters.

To enter non-alphanumeric octets, use “%nn,” where nn is two hexadecimal digits 
representing the value of the character.

Note: The default password for logging in as an admin is “pass.” If you have changed the 
password, you will need to use your password instead of “pass.”
56 PX4i and PX6i High Performance Printer User Guide



2. Send one of the following WPA/WPA2 ON commands to set up WPA-802.1x or 
WPA2-802.1x authentication. You should also send the WPA_PSK command 
that does not contain a value:
setup "wlan","WPA","OFF"
setup "wlan","WPA2","ON"
setup "wlan","WPA_PSK",""
setup write "wlan","uart1:"

3. To view the 802.1x values, send this command:
setup write "8021x","uart1:"

4. Send these commands to configure the EAP_TYPE:
setup "8021x","EAP_TYPE","xxxx"
where xxxx can be OFF, LEAP, PEAP, TTLS, or EAP-FAST.
setup "8021x",".EAP_USER","xxxx"
setup "8021x","EAP_PASS","xxxx"
where xxxx is the unique username and the unique password for 

this protocol.
5. If you are using TTLS, you may need to send this command to set the TTLS 

outer name:
setup "8021x","TTLS_USER","xxxx"
where xxxx is the outer name.

6. If you are using EAP-FAST, you can use PAC and ACQUIRE_PAC commands. 
The PAC setting specifies the PAC file to use for EAP-FAST authentication. The 
ACQUIRE_PAC setting checks to see if automatic PAC file provisioning is 
enabled. You can set ACQUIRE_PAC to on or off.

• Send the following command to set PAC to use /tmp/my.pac with a pass phrase 
of “verysecret”:
setup "8021x","PAC","/tmp/my.pac@verysecret"

• Send the following command to set ACQUIRE_PAC to on:
setup "8021x","ACQUIRE_PAC","ON"

7. If you are using certificates for validation, here are some commands you may 
need to use.

• Send the following commands to set a certificate and enable validation:
setup "8021x","CA_CERT","c:/test.pfx@export"
setup "8021x","VALIDATE","ON"
where c:/test.pfx is the location and name of the certificate 

on the printer and export is the passphrase.
• Send the following commands to set a common name for server 1 and server 2:

setup "8021x",".SERVER_CN1","xxxxxxxxxx"
setup "8021x",".SERVER_CN2","xxxxxxxxxx"
where xxxxxxxxxx is at least 8 characters but less than 96 

characters.
• Send the following commands to make sure your values match those used by 

the access point:
setup write "8021x","uart1:"
setup write "wlan","uart1:"
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• You may need to send the following command several times for the wireless 
station to connect:
setup "wlan","ACTIVE","1"<ETX>

Configuring 802.11 Wireless Security Using IPL
Use the following procedures to configure 802.11 wireless security parameters on 
your printer using IPL.

To configure the printer to use WEP authentication

1. Send the following commands to login as an admin and set the SSID:
<STX><ESC>.x,su -p pass admin<ETX>
<STX><SI>ws,SSID,xxxxx<ETX>
where xxxxx can be from 0 to 32 ASCII characters.

To enter non-alphanumeric octets, use “%nn,” where nn is two hexadecimal digits 
representing the value of the character.

Note: The default password for logging in as an admin is “pass.” If you have changed the 
password, you will need to use your password instead of “pass.”

2. Send the following commands to configure the WEP keys. The following 
example sets WEP key 1 to 01234 and enables WEP key 1.
<STX><SI>ws,WEP1,0x3031323334<ETX>
<STX><SI>ws,.WEP_KEY,1<ETX>

3. Send the following command to activate the settings.
<STX><SI>ws,ACTIVE,1<ETX>

To configure the printer to use WPA-PSK or WPA2-PSK mode

1. Send the following commands to login as an admin and set the SSID:
<STX><ESC>.x,su -p pass admin<ETX>
<STX><SI>ws,SSID,xxxxx<ETX>
where xxxxx can be from 0 to 32 alphanumeric characters.

To enter non-alphanumeric octets, use “%nn,” where nn is two hexadecimal digits 
representing the value of the character.

Note: The default password for logging in as an admin is “pass.” If you have changed the 
password, you will need to use your password instead of “pass.”

2. Send one of the following commands to turn on WPA or WPA2 authentication. 
Send the WPA-PSK or WPA2-PSK command to set a pre-shared key:
<STX><SI>ws,WPA,OFF<ETX>
<STX><SI>ws,WPA2,ON<ETX>
<STX><SI>ws,WPA_PSK,xxxxxxxxxx<ETX>
where xxxxxxxxxx is a value between 8 and 64 characters.

3. Send the following command to activate the settings:
<STX><SI>ws,ACTIVE,1<ETX>
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To configure the printer to use WPA or WPA2 Enterprise mode

1. Send the following commands to login as an admin and set the SSID:
<STX><ESC>.x,su -p pass admin<ETX>
<STX><SI>ws,SSID,xxxxx<ETX>
where xxxxx can be from 0 to 32 alphanumeric characters.

To enter non-alphanumeric octets, use “%nn,” where nn is two hexadecimal digits 
representing the value of the character.

Note: The default password for logging in as an admin is “pass.” If you have changed the 
password, you will need to use your password instead of “pass.”

2. Send one of the following commands to enable WPA-802.1x or WPA2-802.1x 
authentication. You should also send the WPA_PSK command that does not 
contain a value:
<STX><SI>ws,WPA,OFF<ETX>
<STX><SI>ws,WPA2,ON<ETX>
<STX><SI>ws,WPA_PSK, <ETX>

3. Send these commands to configure the EAP_TYPE:
<STX><SI>ws,EAP_TYPE,xxxx<ETX>
where xxxx can be OFF, LEAP, PEAP, TTLS, or EAP-FAST.
<STX><SI>ws,.EAP_USER,xxxx<ETX>
<STX><SI>ws,EAP_PASS,xxxx<ETX>
where xxxx is the unique username and the unique password for 

this protocol.
4. If you are using TTLS, you may need to send this command to set the TTLS 

outer name:
<STX><SI>ws,TTLS_USER,xxxx<ETX>
where xxxx is the outer name.

5. If you are using EAP-FAST, you can use PAC and ACQUIRE_PAC commands. 
The PAC setting specifies the PAC file to use for EAP-FAST authentication. The 
ACQUIRE_PAC setting checks to see if automatic PAC file provisioning is 
enabled. You can set ACQUIRE_PAC to on or off.

• Send the following command to set PAC to use /tmp/my.pac with a pass 
phrase of “verysecret”:

<STX><SI>ws,PAC,/tmp/my.pac@verysecret<ETX>
• Send the following command to set ACQUIRE_PAC to on:
<STX><SI>ws,ACQUIRE_PAC,ON<ETX>

6. If you are using certificates for validation, here are some commands you may 
need to use.

• Send the following commands to set a certificate and enable validation:
<STX><SI>ws,CA_CERT,c:/testCA.pfx@export<ETX>
<STX><SI>ws,VALIDATE,ON<ETX>
where c:/testCA.pfx is the location and name of the certificate 

on the printer and export is the passphrase.
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• Send the following commands to set a common name for server 1 and server 
2:

<STX><SI>ws,.SERVER_CN1,xxxxxxxxxx<ETX>
<STX><SI>ws,.SERVER_CN2,xxxxxxxxxx<ETX>
where xxxxxxxxxx is at least 8 characters but less than 96 

characters.
• Send the following command to make sure your values match those used by 

the access point:
<STX><SI>wt<ETX>

All variables are returned with the exception of EAP_PASS which always returns 
“****” if configured and CA_CERT which transmits the name of the last certificate 
authority successfully installed. An additional read-only variable for the supplicant 
state, called STATE, is also returned.

• You may need to send the following command several times for the wireless 
station to connect:

<STX><SI>ws,ACTIVE,1<ETX>

Connecting Peripherals to the USB Host Port
You can connect these peripheral devices to the USB host interface port on the 
printer:

• USB mass storage device

• Keyboard

• Bar code scanner

• USB hub

Using a USB Mass Storage Device
You can use a USB mass storage device (thumb drive) to store additional fonts and 
images for the printer. You can also use the device to upgrade your firmware. For 
more information on using the USB mass storage device to upgrade the printer, 
see "Upgrading Firmware" on page 83.

To verify the USB storage device is supported by your printer, insert the USB stor-
age device in the appropriate slot on the back of your printer. On the display screen, 
one of the following status messages briefly appears:

• USB memory stick connected

• USB memory stick not supported

If no status message appears when you insert the USB storage device, you can 
manually verify the USB storage device is supported using HyperTerminal.
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To verify the USB storage device is supported by your printer
1. Connect one end of your serial cable to your printer, and connect the other end 

to your PC. 

2. On your PC, open HyperTerminal.

3. In HyperTerminal, use one of the following Fingerprint commands:

• Type DEVICES. The list of devices your printer supports appears. If the USB 
storage device is supported, it appears as drive d: in this list.

• Type Run “cd d:” and press Enter.
Type Run “ls” and press Enter. If the USB storage device is supported, the 
contents of the USB storage device appears.

Connecting a Keyboard to the USB Host Port
You can use an external USB keyboard to input data in Fingerprint applications. 
Some applications may require more complex input from users than the simple 
push of a button.

The printer comes with five keyboard layouts: US, Swedish, French, German, and 
User Defined.

To change the keyboard layout
1. Plug your USB keyboard into the USB host connector on the back of the printer.

2. Turn on the printer.

3. On your printer keypad, press .

4. Navigate to COM > USB KEYBOARD.

5. Choose a keyboard layout.

6. Exit Setup mode by pressing  again.

Connecting a Bar Code Scanner to the USB Host Port
If your printer is running Fingerprint, you can connect a HID (Human Interface 
Device) bar code scanner to the printer. The “usbhost:” device receives data from 
the scanner the same way it does from a USB keyboard. You can then use this data 
in a Fingerprint application.

The keyboard layout you choose (see the previous procedure) applies for con-
nected scanners too.

Setup

Setup
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Connecting a USB Hub to the USB Host Port
You can connect a USB hub to the printer so that you can connect several USB 
devices to the printer at the same time.

Note: If the USB hub is not powered, you can only connect one USB mass storage device 
and one HID (keyboard or scanner) peripheral to the USB hub at a time. If the USB 
hub is powered, you can connect multiple USB mass storage devices and multiple 
HID peripherals at once.
62 PX4i and PX6i High Performance Printer User Guide



CHAPTER

3

PX4i and PX6i Hi
CONFIGURING THE PRINTER
You can change the configuration settings of your printer:

• directly from the screen.

• from the printer home page.

• using PrintSet.

• using commands sent from your PC.

• remotely using SmartSystems Foundation.

• remotely using Wavelink Avalanche.

Configuring Your Printer From the Screen
To configure your printer from the screen, you need to enter Setup mode.

To enter Setup mode

Press the  button.

You mainly use the arrow keys to navigate in Setup mode.

Use This Key: To Do This:

 or 
Scroll through the main menu and sub-menus.

Select a sub-menu item.

Exit a sub-menu without changing the setting.

Select a sub-menu item.

Exit Setup mode.

Setup

Enter

Setup
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Use the following illustrations to understand the Setup menu. The main menus of 
the setup tree are organized in a loop. Each main menu branches out to a number 
of sub-menus. If you have optional accessories installed in your printer, the firm-
ware adds the necessary setup parameters to the Setup tree.

The Main Menus in Setup Mode for Fingerprint

The Main Levels of the Setup Menu in IPL

For more information on the IPL and Fingerprint menu systems, "Setup Menus" on 
page 133.

Configuring Your Printer From the Printer Home Page
If you are using an Ethernet or 802.11 wireless connection, you can change config-
uration settings from your printer’s home page.

Note: You should have already connected your printer to your network and obtained an IP 
address. 
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To access your printer’s home page
1. Start your web browser application.

2. In the address field, enter the IP address of your printer.

3. Press Enter. Your printer’s home page appears.

4. The home page displays the assigned name, firmware version, Active 
Command Set, MAC address, and IP address of your printer. The home page 
also displays the contents of the image buffer, as well as the status of the 
Ready-to-Work indicator.

5. Click Configuration.

6. Click the link for the settings you want to configure.

7. When you are prompted, enter your login and password. The default values are: 
login = admin, password = pass.

Use the next sections to understand and configure the settings on each configura-
tion page.

Configuring Communications Settings
Use the communications page to configure serial communications, the communi-
cations interface, and the keyboard layout.
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To configure communications settings
1. Click Printer > Communication.

2. Choose the settings you want to change.

3. Click Submit Setup.

Configuring Media Settings
Use the media page to view and change media settings such as XSTART position, 
media type, and contrast.

To configure media settings
1. Click Printer > Media.

2. Enter the correct information for the media you are using.

3. Click Submit Setup.

Configuring RFID Settings (Printer With RFID Option)
Use the RFID page to configure settings for printing on RFID media.
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To configure media settings
1. Click Printer > Rfid.

2. Enter the correct information for the RFID media you are using.

3. Click Submit Setup.

Configuring Print Engine Settings
Use the print engine page to adjust the media feed direction (start and stop adjust 
positions) and print speed. The value of the head resistance is read-only and is 
measured by the firmware when the printer starts up.

To configure print engine settings
1. Click Printer > Print Engine.

2. Enter the correct information for the print engine.

3. Click Submit Setup.
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Configuring Web Shell Settings
Use the Web Shell page to view and change test and default settings. You can also 
use the Web Shell page to print test labels and change the command language.

To configure Web Shell settings
1. Click Printer > Web Shell.

2. Select the action you want to take or the setting you want to change.

• For the actions in the top of the screen, the printer performs the action and may 
prompt you to reboot the printer.

• For the settings in the bottom of the screen, select the settings you want and 
click Submit Setup. A message appears stating, “Application change will take 
effect at reboot.” You can select Reboot or wait until you are done making other 
configuration changes.

Use the following table to understand the Web Shell settings.

Setting Description
Testfeed [value] Calibrates the label stop sensor performs a testfeed. Selecting this setting is 

equivalent to issuing the TESTFEED command on the printer.

Ribbon Sensor 
[value]

Detects if the printer runs out of ribbon during printing.

Default Setup Returns the printer to factory default settings. Passwords, alerts, and the 
selected application are not changed.

Reboot Reboots the printer.

Print Test Label Prints the predefined test label you choose.

Command 
Language

Sets the command language to Fingerprint, Direct Protocol, IPL, ZSim, or 
DSim. You need to reboot the printer for the change to take effect.

Fingerprint 
Application

Defines the application to run as the default on startup. You need to reboot 
the printer for the change to take effect.

Standard I/O Defines the port the printer listens to. You need to reboot the printer for the 
change to take effect.
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Configuring Alerts
Use the Alerts page to view and change the printer alert settings.

To configure alerts
1. Click Printer > Alerts.

2. Change the alert settings:

• From the Setting list, choose Enabled or Disabled.

• In the text field, specify a Delay repeat.

• In the Delay Unit list, select seconds or occurrences.

• In the Message text field, enter a message.

3. Select the Notification method.

4. Click Submit Settings.

Use the following table to understand the Alert Settings.

Setting Description
Label Not Taken 
(Fingerprint only)

Sent when the printed label is not taken from the printer. This setting 
applies to label and ticket media and requires an optional label taken 
sensor.

Cutter Error There was an error related to the label cutter.

Head Lifted A printer job was sent to the printer while the printhead was lifted.

Out of Ribbon You have thermal transfer ribbon selected and the printer is out of 
ribbon.

Pause Mode The printer is in Pause mode.

Setup Mode The printer is in Setup mode.

Error Condition 
(Fingerprint only)

An error has occurred in the Fingerprint application. The error does not 
have to be critical to the print job for the printer to send this alert.

Application Break 
(Fingerprint only)

A running Fingerprint application has been interrupted manually or 
because of an error.
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Configuring General Network Settings
Use the General network page to view the printer name, change passwords, and set 
restrictions.

To configure general network settings
1. Click Network Admin > General.

2. View or update your settings.

Note: To enter a new password, you need to check the Set password check box.

3. Click Submit General settings.

Use the following table to understand the general network settings.

Print Job Complete 
(Fingerprint only)

The print job has been successfully completed.

Odometer Count 1 The amount of media printed has reached a preset amount, measured in 
meters or in number of labels. The Delay repeat setting represents how 
often the alert message will be sent when the preset value is reached.

Notification Method The method used to send an alert message. You can choose from mail, 
SNMP-trap, or both. 

Setting Description

Setting Description
Printer Name The network identification name (WINS name) of the printer. The default 

name is HONEYWELL followed by the last six positions of the MAC 
address.

System Location (Optional) The printer location.

System Contact (Optional) The printer administrator.

Set Password You must check this box if you want to change the admin password.
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Configuring Mail Settings
Use the mail settings page to view and change e-mail (SMTP) server settings.

To configure mail settings
1. Click Network Admin > Mail.

2. Select the mail server settings and enter mail addresses.

3. Click:

• Submit Mail Settings to send the changes to the printer.

• Submit & Send test mail to send the changes to the printer and test your new 
settings.

Old Admin Password You need to enter the old password before you can change the 
password.

New Admin Password The new password you want to use.

Restrictions Sets restrictions on who is allowed to upgrade the printer firmware or 
view and change network settings. You cannot remove “admin” from the 
list of authorized users.
Users allowed to update: Defines who may perform a firmware upgrade 
using FTP, PrintSet, or IFAB. This setting does not affect upgrading from 
a Compact Flash card.
Users allowed to read/write protected LAN1 settings: (Fingerprint 
only) Defines who may read/write settings in the LAN1 section.
Users allowed to change network settings: (Fingerprint only) Defines 
who may change the network node in the setup. This setting is not 
supported if you are setting up the printer from its internal keyboard.
Users allowed to change wireless settings: Defines who may change 
WLAN or 802.1x settings.

Setting Description
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Use the following table to understand the mail settings.

Configuring SNMP Settings
Use the SNMP page to view and change SNMP settings.

To configure SNMP settings
1. Click Network Admin > SNMP.

2. Change the SNMP settings.

3. Click Add to add trap settings. You can define up to four authentication failure 
traps.

4. After you add a trap, it appears in the Trap Address Settings list. You can edit or 
delete each trap in the list by clicking Edit or Delete.

5. Click Submit SNMP settings.

Setting Description
Mail (SMTP) Server Choose a configuration method for your mail server settings:

• SMTP settings from DHCP: Choose this setting if you want the 
printer to receive settings automatically from your DHCP server. This 
setting requires that you choose DHCP and IP Selection in the TCP/
IP section.

• Manual settings: Choose this option to manually configure the Mail 
Server address and port. The default port is 25. 

Mail addresses Defines the e-mail addresses to use when the printer sends alert 
messages:

• From address: The address that displays as the sender of alert 
messages. E-mail will be returned to this address if the recipient is 
unreachable. To prevent e-mail bounces when the recipient is 
unreachable, leave this field empty.

• To address: The recipient of alert messages. To enter several 
addresses, separate them with a comma (,) or a semicolon (;).
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Use the following table to understand SNMP settings.

Configuring TCP/IP Settings
Use the TCP/IP settings page to view and change TCP/IP network settings.

To configure TCP/IP settings
1. Click Network Admin > TCP/IP.

2. View or update your settings.

3. Click Submit TCP/IP settings.

Setting Description
Read Community Community with rights to read the SNMP MIBs.

Read/Write Community Community with rights to read and write SNMP MIBs.

Username Username when using SNMPv3. The default value is “initial”.

Authentication Key The authentication key for SNMPv3. The default value is “auth_key”.

Encryption Key The privacy key for SNMPv3. The default value is “priv_key”.

System Name Administrative name for the SNMP node.

Authentication Failure 
Trap

Defines if a trap is sent when an unauthorized SNMP request tries to 
access the printer. Choose Enable to send the trap.

Trap Address Settings Click Add to specify these trap address settings:

• Trap Address: IP address of the receiver of SNMP traps. You can 
specify up to four trap addresses.

• Trap Port: The port where SNMP traps are sent. The default port if 
162.

• Trap Community: Defines the community to which SNMP traps will 
be sent.

• Friendly Name: A user-defined text string that identifies the trap.

• Trap Enable Status: Defines whether the specified trap is enabled.
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Use the following table to understand the TCP/IP settings.

Configuring the Network Type
Use the Network Type page to choose whether you are using an Ethernet or wire-
less 802.11 network.

Setting Description
IPV4 Settings Configuration method: The method by which an IP address is assigned to the 

printer. You can choose between DHCP, BOOTP, DHCP+BOOTP, or MANUAL.
Address: The current IP address of the printer.
Netmask: Manually assigned netmask for the printer.
Default Router: The IP address of the default router.

IPV6 Settings Configuration method: The method by which an IP address is assigned to the 
printer. You can choose between:

• AUTO: The IP address is obtained using stateless auto-configuration. This 
is the default configuration method.

• AUTO+DHCP: The IP address is obtained using stateless auto-
configuration, but DNS options are obtained using DHCP.

• DHCP: The IP address and DNS options are obtained using DHCP.

• MANUAL: The IP address is set to a static address that you enter in the 
Static Address field.

Current addresses: A list of all the currently configured IP addresses for the 
Ethernet interface. The address starting with FE80:: is the link-local address 
and is available regardless of the configuration method you choose.
Static address: This address applies if you selected manual as the 
configuration method. The IP address 
is specified as an address and a prefix separated by a slash. You can use “::” to 
represent a large number of consecutive zeros. You should typically set the 
prefix to 64.
Example:
2001:DB8:0:F101::2/64

Name Resolution DNS Server: The IP address of the name server.
DNSv6 Server: The IP address of the name server for IPv6.
WINS Server (Primary and Secondary): The IP addresses of the primary and 
secondary WINS servers. If you chose DHCP or BOOTP for the configuration 
method, you may see the currently assigned WINS IP addresses depending on 
the configuration of your DHCP server.

Printer Service NET1 TCP Port Number: The port number for raw TCP. The default is 9100.
NET1 Queuing: Determines whether queuing for the TCP port is turned on, off, 
or enabled for multiple network connections (Multi).
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To configure the network type
1. Click Network Admin > Network Type.

2. Select either Ethernet or Wireless 802.11.

3. Click Submit new settings.

4. Reboot the printer for the changes to take effect.

Note: Once you change the network type to Wireless 802.11, you cannot communicate with 
the printer using Ethernet. You need to change the command through the Setup 
menu or send a command through a serial connection.

Configuring Avalanche Settings
Use the Avalanche page to view and change Wavelink Avalanche settings.
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To configure Avalanche settings
1. Click Network Admin > Avalanche.

2. View or update your settings.

3. Click Submit Avalanche settings.

Use the following table to understand the Avalanche settings.

Configuring SmartSystems Settings
Use the SmartSystems page to view or change the SmartSystems server IP address 
and the master port number.

Setting Description
Enabler Mode Click one of the option buttons:

• Disabled: Disables Avalanche.

• Manual settings: Enables Avalanche. You need to enter the Agent address 
and Port in the text fields.

• Find agent by broadcast: Enables Avalanche and the network connection 
broadcasts to find the agent.

Agent 
authorization

Enter your user name and password in the entry fields.
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To configure the SmartSystems settings
1. Click Network Admin > SmartSystems.

2. View or change the settings.

3. Click Submit SmartSystems settings.

Configuring Wireless LAN Settings
Use the Wireless LAN page to view and change 802.11 settings.

Note: The Wireless LAN settings are only available if your printer has the wireless 802.11 
radio interface option installed and is running Fingerprint 8.77.0 or later, or IPL 
v2.77.0 or later

To configure wireless LAN settings
1. Click Network Admin > Wireless LAN.
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2. View or update your settings.

3. Click Submit 802.11 settings.

Use the following table to understand the Wireless LAN settings.

Configuring 802.1x Settings
The 802.1x settings page is only available if you have the optional wireless inter-
face installed in your printer. Use the 802.1x page to view and change 802.1x secu-
rity settings.

Setting Description
SSID The network name of the printer.

Mode Set the operating mode of the device to Ad-Hoc or Infrastructure.

WEP Set Wired Equivalent Privacy (WEP) to on or off.

WEP Keys You can enter values for up to 4 WEP keys.

Active WEP key Chooses the active WEP key.

Authentication Sets the type of authentication to use for your WEP keys. You can 
choose between Auto, Open System, and Shared.

WPA Sets the Wi-Fi Protected Access (WPA) to either on or off.

WPA Pre-shared key Sets the WPA Pre-shared key.

WPA2 Sets the Wi-Fi-Protected Access version 2 to either on or off.

Roaming setting Sets the roaming reluctancy to 1, 2 or 3. Setting the roaming reluctancy 
to 0 turns off the roaming feature.

Current channel (Read only or read/write for adhoc connections) Shows the current 
channel being used.

AP MAC Address (Read only) MAC address of the access point to which the printer is 
connected.

Signal strength (Read only) Radio signal strength of the access point.

Speed (Read only) Speed of the current connection.

Region (Read only) Shows the country short names provided by the 802.11d 
standard for the currently selected region or country.
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To configure 802.1x settings
1. Click Network Admin > 802.1x.

2. View or update your settings.

3. Click Submit 802.1x settings.

Use the following table to understand the 802.1x settings.

Setting Description
EAP Type Choose the Extensible Authentication Protocol (EAP) type:

• TTLS

• LEAP

• PEAP

• EAP-FAST

• Off (disables 802.1x security) (default)

Inner Authentication 
(TTLS, EAP-FAST, and 
PEAP only)

Choose the inner authentication method:

• PAP (TTLS only)

• MSCHAPv2

• EAP/MSCHAPv2

• EAP/MD5

• EAP/GTC

Outer Name (TTLS only) Specify the EAP identity passed in the clear. The default is anonymous.

PAC- Key A-ID Info The Protected Access Credential (PAC) setting is used to specify the 
PAC file used by EAP-FAST authentication. This setting is automatically 
filled up by the printer if ACQUIRE_PAC is enabled and current installed 
PAC file fails authenticating the printer to the network. You can manually 
import a PAC file using a pass phrase the same way you install a 
certificate.

Automatic Provision 
(PAC)

Set Automatic PAC file Provisioning to on or off.
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Configuring Your Printer With PrintSet
Note: You cannot communicate with the printer using PrintSet through a USB connection. 

To use PrintSet, you must be connected serially or through the Ethernet or 802.11 
network.

PrintSet is a printer configuration tool that allows you to easily change your setup 
parameters. You can also use PrintSet’s setup wizards to guide you through com-
mon configuration tasks. 

To configure the printer with PrintSet
1. Make sure that you have a PC running Microsoft Windows 2000 or later.

2. Download PrintSet from the Downloads page of the Honeywell website at 
www.honeywellaidc.com.

3. Connect your printer to your PC using a serial cable. For help, see "Connecting 
the Printer to a PC Through the Serial Port" on page 49.

Configuring Your Printer With Commands Sent From Your PC
You can change configuration parameters by sending commands directly to the 
printer using your terminal program (HyperTerminal) and a serial or network con-
nection.

If your printer uses the Fingerprint language, you use the SETUP command, fol-
lowed by the node, subnode, and parameters setting. This Fingerprint example sets 
the media setting to labels with gaps:
SETUP "MEDIA,MEDIA TYPE,LABEL (w GAPS)"
If your printer uses the IPL language, you would send this command:
<STX><SI>T1<ETX>

Root Certificate The common name of the installed root CA certificate. You can also 
specify a different certificate (provided that it has already been installed 
on the printer) by entering the path to the new certificate in this field. If a 
pass phrase is required, add it to the end of the path in the form of 
“@passphrase”.

Server Common Name 
#1
Server Common Name 
#2
(TTLS and PEAP only)

Specify common names. If you specify one common name, the server 
certificate common name must match this name for authentication. If 
you specify two common names, the server certificate common name 
must match at least one of them. The default is “” (any common name).

Server Certificate 
Validation (TTLS and 
PEAP only)

Enables certificate validation. Specifies whether or not to check if the 
installed CA certificate is the root of the server certificate.

Setting Description
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To see the node, subnode, and parameters for Fingerprint and IPL, "Setup 
Menus" on page 133.

Fingerprint automatically sends feedback to HyperTerminal as you type. If you 
want to see what you are typing with IPL, you need to perform the following proce-
dure.

To see IPL commands as you type
1. From the HyperTerminal menu, select File > Properties > the Settings tab.

2. Click the ASCII Setup button.

3. Select Echo typed characters locally.

4. Click OK twice.

For more information on how to change configuration settings, see either the Fin-
gerprint Command Reference Manual or the IPL Command Reference Manual. 

Configuring Your Printer Using SmartSystems Foundation
SmartSystems™ Foundation is a Honeywell software platform that lets you man-
age all of your SmartSystems-enabled devices simultaneously from a central 
server. The SmartSystems Console displays all SmartSystems-enabled computers 
and peripherals in your network.

Through the Console, you can:

• drag-and-drop configuration bundles, OS updates, and firmware upgrades to 
multiple computers.

• create a “golden” device configuration to use when updating other computers.

• remotely change settings on SmartSystems-enabled computers and 
peripherals.

With an AutoDeploy license, SmartSystems can automatically push software, con-
figuration settings, and other files to connected PX4i and PX6i printers. AutoDe-
ploy can report on asset locations and battery status, making it easier to manage 
your mobile devices. The license also enables Scan-to-Connect, which makes con-
necting additional PX4i and PX6i printers to your secure wireless network as easy 
as reading bar codes.

You can download SmartSystems Foundation at no charge from the Honeywell 
website. For more information on SmartSystems, go to www.honeywellaidc.com/
SmartSystems. To purchase an AutoDeploy license, contact your local Honeywell 
sales representative.

Configuring Your Printer Using Wavelink Avalanche
You can use the Wavelink Avalanche device management system to configure all of 
your wireless printers. You printer ships with the Avalanche Enabler already loaded. 
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Each time the Avalanche Enabler is activated (typically on a warm boot), the printer 
attempts to connect to the Avalanche Agent. When the printer connects to the 
Agent, the Agent determines whether an update is available and immediately starts 
the software upgrade, file transfer, or configuration update.

To use Avalanche to remotely manage the printer
1. Install the configuration updates for the printer using the Avalanche Adminis-

trative Console.

2. Schedule the printer updates or manually initiate an update using the 
Avalanche Administrative Console.

For more information on using Wavelink Avalanche, contact your local Honeywell 
representative or visit the Wavelink website at www.wavelink.com.

Choosing an Ethernet or Wireless Network
If you have an 802.11 wireless radio option installed in your printer, you need to 
choose between an Ethernet network or a wireless 802.11 network.

You can choose the network type of your printer:

• directly from the screen.

• using commands sent from your PC.

• using SmartSystems Foundation. For help, see "Configuring Your Printer Using 
SmartSystems Foundation" on page 81.

• from the printer home page. For help, see "Configuring the Network Type" on 
page 74.

• using PrintSet. For help, see "Configuring Your Printer With PrintSet" on 
page 80.

Choosing the Network Type From the Printer Screen
To configure the printer from the screen, you need to enter Setup mode.

To choose the network type from the printer screen

1. Press  to enter Setup mode.

2. Navigate to Network > Network Type and press .

3. Select either Ethernet or Wireless 802.11 and press .

4. Press  to exit Setup mode.

5. Reboot the printer for the change to take effect.

Setup

Enter

Enter

Setup
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Choosing the Network Type Using Printer Commands
You can use a serial connection to send Fingerprint or IPL commands the printer.

To choose the network type using printer commands
1. Connect your printer to your PC using a serial cable. For help, see "Connecting 

the Printer to a PC Through the Serial Port" on page 49.

2. Start a terminal application, such as HyperTerminal.

• If you are running Fingerprint, send this command to the printer:
setup "NETWORK","NETWORK TYPE","n"
where n is either Ethernet or Wireless 802.11.

• If you are using IPL, send this command to the printer:
<STX><SI>n,,,p<ETX>
where p is either 0 (select Ethernet interface) or 1 (Select 

Wireless 802.11 interface).
3. Reboot the printer for the change to take effect.

Upgrading Firmware
The latest firmware and software is available for download from the Downloads 
page on the Honeywell website at www.honeywellaidc.com. You can upgrade your 
printer’s firmware using:

• PrintSet. You can download PrintSet from the downloads page for the printer on 
the Honeywell website at www.honeywellaidc.com.

• a CompactFlash (CF) card.

• a USB storage device (maximum 2 GB).

• a serial or USB connection.

• an Ethernet or 802.11 network connection.

To download firmware updates
1. Go to the Honeywell website at www.honeywellaidc.com.

2. Click Support > Downloads.

3. Use the Product Category, Product Family, and Product fields, to select the 
printer.

4. Click Submit.

5. The latest available software appears on the page.

6. Download the latest firmware version to your PC.

7. Extract the .zip file to a folder on your PC.
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To upgrade using PrintSet
1. Download the latest version of PrintSet from the Honeywell website at 

www.honeywellaidc.com.

2. Select File > Add Printer. The Add Printer Wizard starts.

3. Under My Printers, select your printer.

4. Go to Printer > Firmware Wizard. 

5. Follow the steps to update your firmware.

To upgrade using a CF card
1. Copy the firmware upgrade file to a CF card.

2. Insert the CF card in the appropriate slot on the back of your printer.

3. Turn on your printer.

To upgrade using a USB storage device
1. Turn on your printer.

2. Verify the USB storage device is supported by your printer. Insert the USB 
storage device in the appropriate slot on the back of your printer. On the display 
screen, one of the following status messages briefly appears:

• USB memory stick connected

• USB memory stick not supported

Note: If not status message appears when you insert the USB storage device, remove and 
reinsert the USB storage device. To manually verify the USB storage device is 
supported, "Using a USB Mass Storage Device" on page 60.

3. Insert the USB storage device in the appropriate slot on your PC.

4. In the root directory of the USB storage device, create a folder named 
“upgrade.”

5. Copy the firmware binary upgrade file to the upgrade folder on the USB storage 
device.

Note: The printer supports 8.3 binary filenames, which mean the filename can have up to 
eight characters and a .bin extension.

6. Insert the USB storage device in the appropriate slot on the back of your printer. 
The upgrade starts. On the display screen, the status message, “Time Out,” 
appears.

7. When the upgrade is complete, the status message, “Check Integrity,” appears. 
Remove the USB storage device. You may need to restart your printer.
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To upgrade using a serial or USB connection
Use Fingerprint or IPL commands to send the upgrade file to your printer. 

For help, see the Fingerprint Command Reference Manual or the IPL Command 
Reference Manual. 

To upgrade using an Ethernet or 802.11 network connection
1. Start your web browser application.

2. In the address field, enter the IP address of your printer.

3. Press Enter. Your printer’s home page appears.

4. From the menu at the top of the page, click Maintenance. The firmware upgrade 
screen appears.

5. Click Browse and browse to the location of the firmware upgrade file.

6. Double-click the file, and then click Upgrade.

Downloading Fonts and Graphics
The printer supports 15 scalable Unicode TrueType and TrueDoc fonts as standard. 
The Unicode standard allows the use of special characters for various languages 
including non-Latin fonts, such as Arabic, Cyrillic, Chinese (including enhanced 
Simplified Chinese GB18030), Japanese, Korean, and Hebrew.

You can download additional fonts to the printer’s Flash memory using:

• PrintSet. You can download PrintSet from the downloads page for the printer on 
the Honeywell website at www.honeywellaidc.com.

• Fingerprint or IPL commands. For help, see the Fingerprint Command Reference 
Manual or the IPL Command Reference Manual. 

• a CompactFlash card or external 2 GB USB mass storage device.
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CHAPTER

4

PX4i and PX6i Hi
TROUBLESHOOTING
Troubleshooting the Printer
You may have printer operation, print quality, or printer communication problems 
at some time during the life of your printer. You can easily fix most of the problems 
you encounter. If you cannot find the answer to your problem in this section, you 
may need to contact Product Support.

Understanding Error Messages
Use the following tables to troubleshoot common error messages you may see dis-
played on your printer’s screen. Keep in mind that some error messages:

• are specific to the type of firmware you are running.

• have corresponding error numbers.

• cause the Ready-to-Work indicator to blink or turn off. 
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Fingerprint Error Messages
Message Description Ready-to-Work 

Indicator 
Status

Error 
Number

Out of paper The printer is out of paper. Load a new roll of media. For help, see 
"Loading Media" on page 5.

Blinking 1005

Next label not 
found

Next label not found Blinking 1031

Label not taken Label not taken Blinking

Out of transfer 
ribbon

The printer is out of transfer ribbon. Load a new roll of ribbon. For 
helps, see "Loading Ribbon" on page 38.

Blinking 1027

Transfer ribbon 
is installed

This is not an error condition. This message briefly appears after a 
new roll of transfer ribbon is installed.

Blinking 1058

Head lifted The printhead is lifted. Lower the printhead. Blinking 1022

Cutter does not 
respond

Open and shut the cutter. Blinking 1059

Cutter error1 Open and shut the cutter. Blinking 1701

Cutter error2 Open and shut the cutter. Blinking 1702

Cutter error3 Open and shut the cutter. Blinking 1703

Cutter open Shut the cutter. 1704

LSS too high This error can occur when you run a test feed without any media 
installed, or if you have incorrect media settings. Load the printer 
with media and select the appropriate media type. For help, see 
"Loading Media" on page 5.

Blinking 1007

LSS too low This error can occur when you run a test feed without any media 
installed, or if you have incorrect media settings. Load the printer 
with media and select the appropriate media type. For help, see 
"Loading Media" on page 5.

Blinking 1008

Testfeed not 
done

The printer did not perform a test feed before it printed out test 
labels. Performing a test feed calibrates the sensor. To perform a 

testfeed, press the  button.

Blinking 1606

No RFID support 
installed

The optional RFID interface is not installed in the printer. Blinking 1320

No tag found No RFID tag has been found. Blinking 1321

Pause Mode 
Entered

The print job is paused. Blinking

Setup Mode 
Entered

The printer is in Setup mode. Off

IP link error No network connection. Blinking

IP configuration 
error

The printer is trying to acquire an IP address from the network. 
Wait for the printer to complete the task before taking any action.

Blinking

Generic DP error In Direct Protocol, you can enable error handling for specific 
errors using the ERROR statement. When errors added to the 
built-in error handling occur, this event is set. The text included in 
the SNMP trap is the standard text corresponding to the error.

Blinking
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IPL Error Messages

Press any key to 
continue

If an error occurs in the Fingerprint immediate mode, for example 
“out of paper” when the print key is pressed, this event is set.

Off

Application load 
error

If an application is started but does not run, the Ready-to-Work 
indicator blinks. For example, if there is a syntax error in the 
loaded program file.

Blinking

RtW blink by 
application

This condition is set by the Fingerprint SYSHEALTH command. 
For more information, see the Fingerprint Command Reference 
Manual.

Blinking

RtW off by 
application

This condition is set by the Fingerprint SYSHEALTH command. 
For more information, see the Fingerprint Command Reference 
Manual.

Off

Application 
break If you perform a user break by pressing  -  to stop an 

application from running, or if a runtime error occurs, the Ready-
to-Work indicator turns off. You can turn the indicator on by 
changing to Direct Protocol or running an application.
But, if the application handles the break (ON BREAK) or runtime 
error (ON ERROR GOTO), the Ready-to-Work indicator is not 
affected, and the application sets the status. For more 
information, see the Fingerprint Command Reference Manual.

Off

Printhead not 
found

Printhead not found. Off

Rebooted The printer has been rebooted. Off

Initializing The printer is initializing. Off

Printer crash Printer crash. In most instances, when the printer crashes, the 
screen is reset which causes the Ready-to-Work indicator to turn 
off.

Off

Printer turned 
off

The printer is off. Off

Maintenance Maintenance Off

Power supply 
Over 
temperature

The power supply is overheated and needs to cool down. Off 1718

Printhead too 
hot

The printhead is overheated and needs to cool down. You need to 
resend your print job.

Off 1088

Message Description Ready-to-Work 
Indicator 
Status

Error 
Number

Paper Out The printer is out of paper. Load a new roll of media. For help, see 
"Loading Media" on page 5.

Blinking 1005

Ribbon Out The printer is out of transfer ribbon. Load a new roll of ribbon. For 
helps, see "Loading Ribbon" on page 38.

Blinking 1031

Message Description Ready-to-Work 
Indicator 
Status

Error 
Number

Shift Pause
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Ribbon Fitted This is not an error condition. This message briefly appears after a 
new roll of transfer ribbon is installed.

Blinking

Printhead Up The printhead is lifted. Lower the printhead. Blinking 1027

Open & Shut 
Cutter

Cutter error 1. Open and shut the cutter. Blinking 1058

Open & Shut 
Cutter

Cutter error 2. Open and shut the cutter. Blinking 1022

Open & Shut 
Cutter

Cutter error 3. Open and shut the cutter. Blinking 1059

Paper Fault LSS too high. This error can occur when you run a test feed 
without any media installed, or if you have incorrect media 
settings. Load the printer with media and select the appropriate 
media type. For help, see "Loading Media" on page 5.

Blinking 1701

Paper Fault LSS too low. This error can occur when you run a test feed without 
any media installed, or if you have incorrect media settings. Load 
the printer with media and select the appropriate media type. For 
help, see "Loading Media" on page 5.

Blinking

Paper Fault The printer did not perform a test feed before it printed out test 
labels. Performing a test feed calibrates the sensor. To perform a 

testfeed, press the  button.

Blinking

Press Feed
Press the  button to resume.

Blinking

Paused This is not an error condition. This message appears when the 
print job is paused.

Blinking

Setup mode entered. Off

IP link error. No network connection. Blinking

IP configuration error. The printer is trying to acquire an IP 
address from the network. Wait for the printer to complete the 
task before taking any action.

Blinking

No Printhead Printhead not found Off

Rebooted Off

Initializing Off

Printer crash. In most instances, when the printer crashes, the 
screen is reset which causes the Ready-to-Work indicator to turn 
off.

Off

Printer turned off Off

Maintenance Off

Psu Over Temp Power supply over temperature Off

Printhead Hot The printhead is overheated and needs to 
cool down. Wait for printing to resume automatically.

Off

Message Description Ready-to-Work 
Indicator 
Status

Error 
Number

Feed
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Troubleshooting Printer Problems and Finding Solutions
Use this section to find possible solutions to printer problems.

Print Quality Problems and Possible Solutions
Problem Possible Solution

The printout is weak, overall. Try these possible solutions in order:

• Make sure that your media setting is appropriate for the type of media you are 
using.

• The contrast may be too low. Try increasing the contrast.

• The printhead pressure may be too low. Increase the printhead pressure. For 
help, see "Adjusting the Printhead Pressure" on page 99.

• Replace the printhead. For help, see "Replacing the Printhead" on page 105.

The printout is weaker on one side. Adjust the pressure arm. For help, see "Adjusting the Pressure Arm" on page 95.

There are weak spots on the 
printout.

Try these possible solutions in order:

• There may be foreign particles on the media. Clean or replace the media.

• Make sure that your media and ribbon are compatible.

• Make sure that you are using high quality media and ribbon.

• The contrast may be too low. Try increasing the contrast.

• The printhead may be worn. Replace the printhead. For help, see "Replacing the 
Printhead" on page 105.

• The platen roller may be worn. For help, contact your service representative.

The printout is dark, overall. 
Or,
There is excessive bleeding on the 
media.

Try these possible solutions in order:

• Make sure that your media setting is appropriate for the type of media you are 
using.

• The contrast may be too high. Try decreasing the contrast.

• The printhead pressure may be too high. Decrease the printhead pressure. For 
help, see "Adjusting the Printhead Pressure" on page 99.

• The printhead voltage may be incorrect or the energy control may be faulty. For 
help, contact your service representative.

There are dark lines along the 
media path.

There may be foreign particles on the printhead. Clean the printhead. For help, see 
"Cleaning the Printhead" on page 103.

There are white vertical lines on 
the printout.

Try these possible solutions in order:

• There may be foreign particles on the printhead. Clean the printhead. For help, 
see "Cleaning the Printhead" on page 103.

• There may be missing dots on the printhead. Replace the printhead. For help, see 
"Replacing the Printhead" on page 105.

Part of a dotted line is missing. Try these possible solutions in order:

• The printhead may be failing. Replace the printhead. For help, see "Replacing the 
Printhead" on page 105.

• The strobe signal may be failing. For help, contact your service representative.
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The inner edge of the printout is 
missing.

Try these possible solutions in order:

• The media may not be properly installed or aligned. Reload the media. For help, 
see "Loading Media" on page 5.

• The small core and supply post may be in the upper position. Move the post to 
the lower position.

• The X-start parameter may be set too low. Increase the setting.

The content on my printout is 
compressed.

The print speed may be too high. Lower the print speed.

Nothing shows up on my thermal 
transfer printout.

The ink-coated side of the ribbon may not be facing the media. Reload the ribbon. 
For help, see "Loading Ribbon" on page 38.

When I feed or print a label, the 
ribbon is not taken up. Instead, it 
spills out of the front of the printer.

Make sure Paper Type is set to Thermal Transfer Ribbon (TTR):

Step 1. On your printer’s keypad, press  to enter the Setup menu.

Step 2. If you are using Fingerprint, go to Media > Paper Type > Transfer.
Step 3. If you are using IPL, go to Media > Paper Type > TTR.

Step 4. Press .

Step 5. Press  to exit the Setup menu.

The transfer ribbon breaks. Try these possible solutions in order:

• Make sure that your media setting is appropriate for the type of media you are 
using.

• Make sure that the ribbon is fitted correctly. Reload the ribbon. For help, see 
"Loading Ribbon" on page 38.

• The energy control may be faulty. For help, contact your service representative.

The transfer ribbon wrinkles. Try these possible solutions in order:

• You may need to adjust the label stop sensor. For help, see "Adjusting the Label 
Stop Sensor" on page 97.

• The printhead pressure may be too high. Decrease the printhead pressure. For 
help, see "Adjusting the Printhead Pressure" on page 99.

The media feed is not working 
properly.

Try these possible solutions in order:

• The media characteristics may have changed. Press the  button.

• One of these parameters may not be properly configured: Label rest dots, Media 
type, or LSS position. Verify the settings for these parameters.

• The sensors may be dirty. Clean the media guides. For help, see "Cleaning the 
Media Guides" on page 101.

• The sensors may need to be replaced. For help, contact your Honeywell service 
representative.

Problem Possible Solution

Setup

Enter

Setup
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Networking Problems and Possible Solutions

RFID Problems and Possible Solutions

Problem Possible Solution

I am having problems with my Ethernet or 
802.11 radio network connection.

Try these possible solutions:

• Make sure that your network cable is:

• securely connected to your printer.

• a straight “pin to pin” cable, not a “crossover” cable.

• Make sure that your PC is correctly configured for and connected to 
your network.

• Make sure that your printer is correctly configured for your network.

I cannot connect to my printer home page. If you are connecting your printer with a crossover network cable, you may 
need to disable the web browser’s proxy settings on your computer to 
access your printer’s home page.

Problem Possible Solution

I loaded my printer with RFID media, but it is 
not writing to the tags.

After you load RFID media, restart the printer or run a TESTFEED to let the 
printer identify the RFID media type.

The RFID kit is installed, but “RFID” does not 
appear in the setup tree.

The printer is not communicating properly with the RFID hardware. For 
help, contact your local Honeywell representative.

When I try to set RFID MODE to ENABLE, I 
get one of these error messages:

• “Error in filename” (Fingerprint or Direct 
Protocol)

• “No RFID support” (IPL)

An RFID kit is not installed in the printer. For help, contact your local  
representative.

None of the RFID commands work, and I get 
this message: “RFID Inactive.”

RFID MODE is disabled. Change MODE to ENABLE. 

Printing on regular media (not RFID) is slow 
and halted in between labels.

RFID MODE is enabled. Change MODE to DISABLE. 

I am using an application to write to RFID 
tags, and the printer is printing “VOID” 
labels.

• The printer may not recognize the RFID media type. For Fingerprint 
printers, run a TESTFEED. For IPL printers, raise and lower the 

printhead, and then press  or turn on the printer.

• You may need to modify the TAGADJUST parameter. 

• You may need to adjust the output power (field strength) to the 
antenna. 

When I try to perform a TESTFEED, I get this 
message, “No tag found.”

• Make sure that you are using RFID media.

• You may need to modify the TAGADJUST parameter. 

• The tag may be broken. Try printing on a different label.

I get this error message: “Not supported by 
tag type.” (Fingerprint)

This error message indicates that a command:

• may be trying to access a tag data segment that is not available on the 
RFID media.

• is being used with a level of security that is not allowed by the tag type.
Make sure that you are using the appropriate media for your application.

Feed
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Resetting the Printer
When you reset the printer, you return it to the factory default settings. Resetting 
the printer removes all files used to store settings. But, it does not reset settings 
that have already been read when the files. So, wireless communication settings, 
such as SSID and keys retain their values from the previous start. However, the next 
reboot resets them to the factory default values.

Resetting the printer also does not change the selected printer language (Finger-
print, IPL, ZSim, or DSim).

There are two ways to reset the printer:

• Insert a special CompactFlash memory card and restart the printer.

• Use the printer’s keypad.

To reset the printer using the keypad
1. Turn off the printer.

2. Open the right cover and lift the printhead.

3. Turn on the printer and press and hold the  key until the printer beeps.

When I send a TAGREAD or TAGWRITE 
command, I get this error message: “Tag 
format error.”

The TAGFORMAT defined for the operation determines the number of 
required parameters. You may need to modify the TAGFORMAT. For help, 
see the Fingerprint Command Reference Manual or the IPL Command 
Reference Manual. For more information, see the EPC Tag Data Standard 
(v1.1, revision 1.27) available from the EPCglobal website at 
www.epcglobalinc.org.

Data can be written unlawfully to a write 
protected ISO 18000-6B tag.

For some ISO 18000-6B tag chips, the functionality to protect the tag 
memory from being rewritten has not been implemented. Switch to tags 
with a different chip that have this functionality implemented.

I can read ISO 18000-6B tags, but when I try 
to read Class 1 tags, I get this error message: 
“No tag found.”

Class 1 tags require an MPR6100 RFID Radio Module. To order an 
MPR6100 kit, contact your local representative.

(Fingerprint only) My printer displays an 
error code.

Use the error code text to troubleshoot the problem:
1320 No RFID support installed.
1321 No tag found.
1322 Access outside tag memory.
1323 Tag format error.
1324 RFID inactive.
1325 Not supported by tag type.
1326 RFID module too hot.
1327 RFID duty cycle exceeded.
1328 RFID lock error. Tag cannot be locked.
1329 RFID access error. Tag is locked.

Note: If you are using Direct Protocol, error codes 1320 to 1329 are 
supported and displayed with the error text.

Problem Possible Solution
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4. Quickly press the following keys in sequence:

   
5. The following message appears:

Factory Default?
Enter=Yes ESC=No

6. Within 10 seconds, press  to reset the printer to its factory default settings. 
The parameters are reset and the printer continues the normal startup process.

7. If you do not press  within 10 seconds, the normal startup continues and 
the printer is not reset.

Adjusting the Printer
You may need to adjust your printer to accommodate your printing needs or 
improve performance. You can adjust the:

• pressure arm.

• label stop sensor (LSS) position.

• printhead pressure.

• label taken sensor.

Adjusting the Pressure Arm
The printer is factory-adjusted for full-size media width. If you are using media that 
is less than full width, Adjust the position of the pressure arm so that it is centered 
on the media and provides even pressure.

A poorly adjusted pressure arm may be detected by a weaker printout on either side 
of the media path.

To adjust the pressure arm
1. Turn off the printer.

Enter

Enter
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2. Open the front door and media cover.

3. If necessary, remove the ribbon.

4. Loosen the knob that secures the pressure arm.

5. Move the pressure arm inward or outward until the arrow on the tip of the arm is 
centered with the media.

Note: Move the pressure arm at the part closest to the knob, not at the tip. If the arm is 
difficult to move, lift the printhead and pull the printhead bracket free from the 
magnet in the arm.

6. When the pressure arm is centered, tighten the knob to secure the arm.

7. Adjust the edge guides.

8. If necessary, load ribbon.

9. Close the front door and media cover.

Center of
media 

Pressure arm

Knob

Edge guides
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Adjusting the Label Stop Sensor
The label stop/black mark sensor (LSS) is a photoelectric sensor that controls the 
printer’s media feed by detecting gaps between labels, or slots or black marks in 
continuous stock, depending on the printer’s media type setup. The LSS must be 
aligned with the gaps, slots, or black marks. If you are using irregularly shaped 
labels, align the LSS with the front tips of the labels.

The LSS can be moved laterally from the inner edge of the media path to 50 mm 
(1.96 in) outward, which corresponds to the center line of full width media. One 
part of the sensor is on the upper media guide and the other part of the sensor is 
under the lower guide. 

To adjust the LSS
1. Use a slotted screwdriver to turn the adjustment screw. 

• Rotate the screw clockwise to move the sensor toward the center section.

• Rotate the screw counterclockwise to move the sensor outward, away from the 
center section.

2. Look at the print mechanism from the front with the printhead lifted to make 
sure that the point of detection on the upper sensor is aligned with the center of 
the slots or marks in the media. 

Note: You can also use the markings, spaced at 1 cm (0.39 in) intervals, on the lower guide 
plate. This method can be especially useful for black marks. Be sure to measure the 
lateral position of the black marks with a ruler before loading the media.

Upper part of LSS
Detection slots

Adjustment 
screw
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To test the LSS
1. Make sure that your printer is properly configured for the type of media you are 

using. Go to SETUP > MEDIA > MEDIA TYPE.

2. Open the media cover.

3. Lift and lower the printhead.

4. Press the  button.

5. Make sure there is a label (not a gap or mark) at the LSS.

6. Make sure that the media is routed as close to the center section as the guide 
allows.

7. Press  to enter the Setup menu, and use the keypad to go to the LSS menu:

• If you are running Fingerprint, go to SETUP > PRINT DEFS > LSS TEST > LSS 
AUTO.

• If you are running IPL, go to SETUP > TEST/SERVICE > LSS TEST > LSS AUTO. 

8. The screen displays the LSS AUTO menu with the cursor in the center.

Note: There is no way to adjust the LSS function; the menus only indicate values obtained 
from the LSS. The test menu can determine if the sensor unit is not physically in 
position, is blocked by dust or stuck labels, or is defective in some way.

9. Check gap detection:

• Lift the printhead.

• Slowly pull out the media. When the LSS detects a gap or detection slot, the 
cursor moves to the right.

10. Check mark detection:

• Lift the printhead.

• Slowly pull out the media. When the LSS detects a black mark, the cursor moves 
to the left.

Setup

LSS AUTO

    �

LSS AUTO

         �

LSS AUTO

�
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11. If the LSS does not move as described in Steps 8 and 9, make sure that:

• the cursor position is accurate. Refresh the cursor position by pressing the  
key.

• the LSS is laterally aligned with the slots or black marks.

• both the upper and lower parts of the LSS are aligned with each other.

• the transfer ribbon is properly loaded so it does not interfere with the LSS. For 
help, see "Loading Ribbon" on page 38.

• the LSS guides are clean and free from stuck labels or other objects that may 
interfere with the light that goes from one part of the LSS to the other. For help, 
see "Cleaning the Printer" on page 101.

• the media does not have some kind of preprint that may disturb detection.

• there is enough difference between the black marks and the surrounding areas.

• the liner is transparent enough.

• the LSS works properly with another type of media.

Adjusting the Printhead Pressure
The pressure of the thermal printhead against the direct thermal media is factory-
adjusted. But, you may need to adjust the printhead pressure to accommodate 
thicker or thinner media.

Note: Do not use a higher printhead pressure than necessary, because it may increase the 
wear of the printhead and shorten its life.

To adjust the printhead pressure
1. Turn the adjustment knob clockwise for more pressure and a darker printout (+) 

or counter-clockwise for less pressure (-) and a lighter printout.
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2. Print test labels to check the print quality. For help, see "Printing a Test 
Label" on page 45.

To return the printhead pressure to the factory default setting
Tighten the knob (+) as much as you can, and then loosen it (-) four full turns.

Adjusting the Label Taken Sensor
If you are using the optional label taken sensor (LTS), you may need to adjust the 
sensitivity depending on ambient light conditions and the reflective characteristics 
of the back side of the media.

To adjust the LTS

1. Press  to enter the Setup menu, and use the keypad to go to the LTS menu:

• If you are running Fingerprint, go to SETUP > PRINT DEFS > LTS.

• If you are running IPL, go to SETUP > TEST/SERVICE > LTS.

2. Modify one or more LTS settings.

Maintaining the Printer
To keep your printer working properly, you should perform regular maintenance.

Setting How to Modify

LTS Adjust Step 1. Press . The printer feeds a label.

Step 2. Remove the label and press  again. 
The printer displays the sensitivity value 
that is automatically selected by the 
firmware and the range in which the LTS 
will work. 

Step 3. Press  again to proceed to the LTS 
Test menu.

LTS Test Step 1. Press . The printer feeds a label.

Step 2. Remove the label. The printer 
automatically feeds another label. 

Step 3. Repeat Steps 1 and 2 until you are sure 
the LTS is working properly. 

Step 4. Press  to stop the test and exit.

LTS Value Step 1. Press .

Step 2. Enter a new LTS value within the range 
indicated in the LTS Adjust menu (0 to 
10).

Setup

Enter

Enter

Enter

Enter

Enter

Enter
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Cleaning the Printer
To properly maintain your printer, you should regularly clean it. You can clean the:

• exterior of the printer.

• media guides.

• printhead.

Follow these guidelines for cleaning the printer:

• Always remove the power cord before cleaning.

• Never spray the printer. Protect it from water when cleaning the premises.

• Never use any sharp tools for removing stuck labels. The printhead and rollers 
are delicate.

Cleaning the Exterior of the Printer
Clean the exterior of the printer as needed.

To clean the exterior of the printer
Wipe external surfaces with a soft cloth slightly moistened with water or a mild 
detergent.

Cleaning the Media Guides
The label stop sensor, which controls the media feed, is covered by two plastic 
guides. The guides are transparent to allow the light to pass between the two parts 
of the label stop sensor. These areas must be kept clean from dust, stuck labels, 
and adhesive residue.

Warning:  To avoid possible personal injury or damage to the printer, 
never insert any pointed or sharp objects into the printer.

Caution:  Use only the cleaning agents specified in this section. 
Honeywell is not responsible for damage caused by any other 
cleaning materials used on this printer. Clean the printer with a 
cotton swab saturated with alcohol.

Caution:  When cleaning or replacing the printhead, take precautions to 
avoid electrostatic discharges.
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If your printer starts to feed labels in an unexpected way, pull out 
the upper guide check for objects, such as dust, adhesive residue, or labels, that 
may be blocking the beam of light. If necessary, clean the guides.

To clean the media guides
1. Open the front door and media cover.

2. Pull the upper guide straight out.

Warning:  Isopropyl alcohol [(CH 3)2CHOH; CAS 67-63-0] is a highly 
flammable, moderately toxic, and mildly irritating substance.
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3. Press the snap-lock, lift the edge of the lower guide, and pull the lower guide 
straight out.

4. Clean the guides with a cleaning card or a soft cloth soaked in isopropyl 
alcohol. Be careful not to scratch the guides.

5. Replace the upper and lower guides. 

Cleaning the Printhead
Cleaning the printhead on a regular basis is important for the life of the printhead 
and for the printout quality. You should clean the printhead each time you replace 
the media. This section describes how to clean the printhead using cleaning cards. 
If additional cleaning is required, for example removing adhesive residue from the 
platen roller or tear bar, use a cotton swab moistened with isopropyl alcohol.

To clean the printhead

1. Turn off the printer.

Warning:  Isopropyl alcohol [(CH 3)2CHOH; CAS 67-63-0] is a highly 
flammable, moderately toxic, and mildly irritating substance.
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2. Open the front door and media cover.

3. Turn the printhead lift lever counter-clockwise to raise the printhead.

4. Remove any media and transfer ribbon.

5. Open the cleaning card envelope and pull out the cleaning card. Read the 
warning text.
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6. Insert most of the cleaning card under the printhead, and then lower the 
printhead.

7. Pull out the cleaning card and raise the printhead.

8. Wait for approximately 30 seconds to allow the cleaning fluid to dissolve the 
residue.

9. Repeat Steps 5 through 7.

10. If necessary, repeat the process with a fresh cleaning card.

11. Allow the cleaned parts to dry before loading media and ribbon.

Replacing the Printhead
The printhead is subject to wear both from the direct thermal media or ribbon and 
from the rapid heating and cooling process during printing. So, you need to period-
ically replace the printhead.

How often you need to replace the printhead depends factors such as the print 
images, the type of direct thermal media or ribbon in use, the amount of energy to 
the printhead, the print speed, and the ambient temperature.

You must turn off the power before replacing the printhead. The firmware can only 
detect the new printhead when the printer is restarted. 

To replace the printhead
1. Turn off the printer.

2.5 cm
(1 in)
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2. Open the front door and media cover.

3. (PX6i only) Pull the locking handle down.

f
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4. Turn the printhead lift lever counter-clockwise to raise the printhead.

5. Remove any media and transfer ribbon.

6. Pull the printhead bracket away from the magnet in the pressure arm.
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7. Disconnect the hooks of the printhead bracket from the shaft, and pull out the 
printhead as far as the cables allow.

8. Disconnect the cables from the printhead. Note the snap-lock on the inner 
connector. Pull at the connectors, not at the cables.
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9. Connect the two cables to the replacement printhead.

10. Connect the hooks of the printhead bracket to the headlift shaft. Make sure that 
the cables are not in the way. 
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11. Turn the printhead lift lever clockwise so the magnet engages the printhead 
bracket.

12. (PX6i only) Push the locking handle up.

13. Load a new supply of media and ribbon. For help, see "Loading Media" on 
page 5 and "Loading Ribbon" on page 38.
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APPENDIX

A

PX4i and PX6i Hi
SPECIFICATIONS
Physical Specifications
PX4i Dimensions:27.5 x 48.2 x 23.8 cm (10.8 x 19.0 x 9.4 in)

PX4i Weight:12.85 kg (28.4 lb)

PX6i Dimensions:33.5 x 48.2 x 23.8 cm (13.2 x 19.0 x 9.4 in)

PX6i Weight:14.8 kg (32.6 lb)

Power Specifications
Printer Voltage:v100-240 V, 3-1A, 50-60Hz

Temperature and Humidity Specifications
Operating Temperature:5 °C to 40 °C (41 °F to 104 °F)

Storage Temperature:-20 °C to 70 °C (-4 °F to 152 °F)

Humidity:10 to 90% non-condensing

Communications and Connectivity
• Serial port (RS-232)

• USB device

• USB full speed host

• Ethernet, 100 Mbps

• 802.11b/g (optional)

• IPv6

Memory
• 32MB RAM

• 16MB Flash

• CompactFlash (CF) card (optional)
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• USB memory device (optional)

Printing Speed and Resolution

Interfaces
This section describes the standard interfaces available on the PX4i and PX6i 
printers.

Specification Description

Print Mode Direct
Thermal Transfer

Print Speed (variable) 100 to 300 mm/sec (4 to 12 in/sec)

Printhead Resolution 8 dots/mm (203.2 dpi)
11.81 dots/mm (300 dpi)
16 dots/mm (406 dpi) (PX4i only)

Print Width (maximum)
PX4i Direct Transfer
PX4i Thermal 

Transfer
PX6i

112 mm (4.41 in)
114 mm (4.5 in) 

167.4 mm (6.59 in)

Print Length (maximum)
Fingerprint

IPL

32767 dots
= 409.5 cm (161.25 in) at 203.2 dpi
= 277.5 cm (109.23 in) at 300 dpi
= 409.5 cm (161.25 in) at 203 dpi

Note: The maximum print length is also restricted by the 
amount of free SDRAM memory.

Media Width
PX4i
PX6i

25 to 120 mm (1 to 4.72 in)
76.2 to 170 mm (3 to 6.69 in)

Media Roll Diameter 
(maximum)

213 mm (8.38 in) Tear-Off
205 mm (8.07 in Peel-Off

Media Roll Core Diameter 38 to 40 mm (1.5 in)
76 mm (3 in) with adapter fitted

Ribbon Width
PX4i
PX6i

55 to 114 mm (2.17 to 4.5 in)
76.2 to 168 mm (3 to 6.61 in)

Ribbon Roll Outer 
Diameter (maximum)

80 mm (3.15 in)
± 450 m (1476 ft) of ribbon

Ribbon Roll Core Inner 
Diameter

25 mm (1 in)

Print Directions 4
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RS-232 Serial Interface
Use this table to understand the default settings of the serial port.

The printer end of the serial cable is a DB9 pin and the PC end is dependent on the 
model of the PC.

RS-232 Serial Cable DB9 Pins

USB Interface
The printer supports USB full speed v2.0 Host. To use the USB interface to print 
from a PC, you need to have the Honeywell printer driver installed on your PC. For 
help setting up USB communications, see "Connecting the Printer to a PC Through 
the USB Device Port" on page 50.

The printer is a “self-powered device.” Only connect one printer to each USB port 
on the PC, either directly or through a hub. You can connect other devices, such as 
a keyboard or a mouse, to the same hub. If you need more than one USB printer to a 
host, you should use different USB ports.

Parameter Default Setting

Baud rate 9600

Character Length or Data Bits 8

Parity None

Stop Bits 1

Handshaking none (Fingerprint XON/XOFF (IPL)

Pin Signal Description

1 External +5 V DC, Max 500 mA

2 TXD Transmit data

3 RXD Receive data

4

5 GND Ground

6

7 CTS Clear to send

8 RTS Request to send

9

1 2 3 4

6 7 8 9

5
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The USB cable that ships with the printer has a USB Type A connector on one end 
to connect to the PC and a USB Type B connector on the other end to connect to 
the printer. You do not need to configure communications for the USB port.

USB Type A Connector

USB Type B Connector

USB Host Interface
The printer has a USB host interface for connecting USB devices such as HID bar 
code scanners and keyboards, USB storage devices, and USB hubs.

USB Host Interface

Ethernet Interface
The Ethernet interface has an RJ-45 socket for use with a standard RJ-45 cable. 
The interface supports 10/100 Mbps Fast Ethernet (10BASE-T, 100BASE-TX) and 
is fully compliant with the IEEE 802.3u standard. The network card MAC address 
can be found on the label below the socket.

Ethernet Socket

Ethernet Connector

Pin Description

1 VBUS

2 D-

3 D+

4 Gnd

1 2 3 4
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One yellow and one green LED indicate the network status.

Understanding the Ethernet LEDs

Parallel IEEE 1284 Interface
The parallel port supports Universal Plug and Play (UPnP) and additional status 
reporting through IEEE 1284 nibble ID mode.

Parallel IEEE 1284 Pins and Descriptions

LED Status Description

Green On Link

Off No link

Blinking Network activity

Yellow On 100BASE-TX

Off 10BASE-T

Pin Description Transmitter Comments

1 nStrobe Host

2 to 9 Data 0-7 Host

10 nAcknowledge Printer

11 Busy Printer

12 Perror Printer

13 Select Printer

14 nAutoFd

15 to 16 Not connected

17 Chassis ground

18 External +5 V DC Max 500 mA

19 to 30 Signal ground

31 nInit

32 nFault Printer

33 Signal ground

34 to 35 Not connected

36 nSelectIn
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Media Specifications
Core and Roll Specifications

Non-Adhesive Strip

Media Width (a)

Media Type
Set media type to one of these values:

• Fingerprint:

• FIX LENGTH STRIP

• VAR LENGTH STRIP

• IPL: CONTINUOUS

Measurement Value

Core inside diameter, standard 38 to 40 mm (1.5 in)

Core inside diameter, with adapter 76.2 mm (3 in)

Core width must not protrude 
outside the media

Maximum roll outside diameter
Tear-off and cut-off
Peel-off and batch takeup

213 mm (8.38 in)
205 mm (8.07 in)

Minimum media width
PX4i 
PX6i

25 mm (1.00 in)
76 mm (3.00 in)

Maximum media width
PX4i 
PX6i

114.3 mm (4.50 in)
170 mm (6.69 in)

Printer Measurement Value

PX4i Maximum 120 mm (4.72 in)

Minimum 25.0 mm (1.00 in)

PX6i Maximum 170 mm (6.69 in)

Minimum 76.0 mm (3.00 in)
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Non-Adhesive Strip

Self-Adhesive Strip
External Media Width Including Liner (a)

Liner (b)
The liner must not extend more than a total of 1.6 mm (0.06 in) outside the face 
material and should protrude equally on both sides.

External Media Width Excluding Liner (c)

a

Non-Adhesive
Strip

Printer Measurement Value

PX4i Maximum 120 mm (4.72 in)

Minimum 25.0 mm (1.00 in)

PX6i Maximum 170 mm (6.69 in)

Minimum 76.0 mm (3.00 in)

Printer Measurement Value

PX4i Maximum 118.4 mm (4.66 in)

Minimum 23.8 mm (0.94 in)

PX6i Maximum 168.4 mm (6.63 in)

Minimum 74.4 mm (2.93 in)
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Media Type
Set media type to one of these values:

• Fingerprint:

• FIX LENGTH STRIP

• VAR LENGTH STRIP

• IPL: CONTINUOUS

Self-Adhesive Strip

Self-Adhesive Labels
External Media Width Including Liner (a)

Liner (b)
The backing paper must not extend more than a total of 1.6 mm (0.06 in) outside 
the labels and should protrude equally on both side. Recommended minimum 
transparency: 40% (DIN 53147).

a

c

bb

SELF-ADHESIVE
STRIP

Printer Measurement Value

PX4i Maximum 120 mm (4.72 in)

Minimum 25.0 mm (1.00 in)

PX6i Maximum 170 mm (6.69 in)

Minimum 76.0 mm (3.00 in)
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Media Width Excluding Liner (c)

Label Length (d)

Note: Under ideal circumstances, a minimum label length of 4 mm (0.16 in) could be used. 
It requires the sum of the label length (d) and the label gap (e) to be larger than 7 mm 
(0.28 in), that batch printing is used, and that no pull back of the media is performed. 
Honeywell does not guarantee that such short labels will work, but it is up to users to 
test this in their unique application.

Label Gap (e)

The Label Stop Sensor (LSS) must be able to detect the extreme front edges of the 
labels.

Printer Measurement Value

PX4i Maximum 118.4 mm (4.66 in)

Minimum 23.8 mm (0.94 in)

PX6i Maximum 168.4 mm (6.63 in)

Minimum 74.4 mm (2.93 in)

Measurement Value

Minimum without LTS 8 mm (0.32 in)

Minimum with LTS 12 mm (0.47 in)

Maximum 6,143 mm (241 in) Depends on SDRAM size.

Measurement Value

Maximum 25.0 mm (0.98 in)

Recommended 3.0 mm (0.12 in)

Minimum 1.2 mm (0.05 in)
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Self-Adhesive Labels

Media Type
Set media type to one of these values:

• Fingerprint: LABEL (w GAPS)

• IPL: GAP

Tickets With Gaps (Gap Stock)
Media Width (a)

c

d

bb

SELF-ADHESIVE
LABELS

FEED 
DIRECTION

Printer Measurement Value

PX4i Maximum 120 mm (4.72 in)

Minimum 25.0 mm (1.00 in)

PX6i Maximum 170 mm (6.69 in)

Minimum 76.0 mm (3.00 in)
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Copy Length (b)

Note: Under ideal circumstances, a minimum ticket length of 4 mm (0.16 in) could be used. 
It requires the sum of the copy length (b) and the detection slit height (e) to be larger 
than 7 mm (0.28 in), that batch printing is used, and that no pull back of the media is 
performed. Honeywell does not guarantee that such short tickets will work, but it is 
up to users to test this in their unique application

LSS Detection Position (c)
This position is variable. For help, see "Adjusting the Label Stop Sensor" on 
page 97.

Detection Slit Length (d)
The length of the detection slit (excluding corner radii) must be a minimum of 2.5 
mm (0.10 in) on either side of the LSS detection position (c).

Detection Slit Height (e)

Media Type
Set media type to one of these values:

• Fingerprint: GAP STOCK

• IPL: GAP

Note: Do not allow a perforation to break the edge of the media, because the media may 
split and jam the printer.

Measurement Value

Minimum without LTS 8 mm (0.32 in)

Minimum with LTS 12 mm (0.47 in)

Maximum 6,143 mm (241 in) Depends on SDRAM size.

Measurement Value

Maximum 25.0 mm (0.98 in)

Recommended 1.6 mm (0.06 in)

Minimum 1.2 mm (0.05 in)
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Tickets With Gaps (Gap Stock)

Tickets With Black Mark (Mark Stock)
Media Width (a)

Copy Length (b)

LSS Detection Position (c)
This position is variable. For help, see "Adjusting the Label Stop Sensor" on 
page 97.

TICKETS & TAGS

bc

d

e

FEED 
DIRECTION

Printer Measurement Value

PX4i Maximum 120 mm (4.72 in)

Minimum 25.0 mm (1.00 in)

PX6i Maximum 170 mm (6.69 in)

Minimum 76.0 mm (3.00 in)

Measurement Value

Minimum 20.0 mm (0.8 in)

Maximum 6,143 mm (241 in) Depends on SDRAM size.
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Black Mark Width (d)

Black Mark Length (e)

Black Mark Y-Position (f)
Place the black mark as close to the front edge of the ticket as possible and use a 
negative Stop Adjust value to control the media feed, so the tickets can be properly 
torn off.

Media Type
Set media type to one of these values:

• Fingerprint: MARK STOCK

• IPL: TICKET (w MARK)

Note: The black mark should be non-reflective carbon black on a whitish background. Do 
not allow a perforation to break the edge of the media, because the media may split 
and jam the printer.

Note: Try to avoid preprint that may interfere with the detection of the black mark. However, 
if your are running Fingerprint, you can use the command LBLCOND to temporarily 
disable the sensor for a specified amount of media feed to avoid unintentional 
detection. For help, see the Fingerprint Command Reference Manual.

Measurement Value

Maximum Full media width

Recommended 10.0 mm (0.39 in)

Minimum 5.0 mm (0.20 in)

Measurement Value

Maximum 25.0 mm (0.98 in)

Recommended 3.2 mm (0.13 in)

Minimum 1.27 mm (0.05 in)
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Tickets With Black Mark (Mark Stock)

Media With RFID Tags or Inlays
When printing on RFID media, special consideration must be taken to the position 
and shape of the tag. Specific recommendations for different kinds of Honeywell-
approved RFID media can be found on the Honeywell website at www.honey-
wellaidc.com. Additional information is provided in the documentation that came 
with your RFID kit.

Accessories for the Printer
You can use these accessories (sold and ordered separately) with the printer. To 
order accessories, contact your local sales representative.

Liner/Batch Takeup
This factory-installed option separates labels from the liner and winds up the 
spent liner inside the printer’s media compartment. For more information on using 
the liner/batch takeup, see "Loading Media for Internal Batch Takeup Printing" on 
page 28.

Paper Cutter
Use the paper cutter to cut through continuous non-adhesive paper-based media 
or the liner between labels. 

bc

e

fd

TICKETS
WITH MARKS

FEED 
DIRECTION
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If you are running Fingerprint or Direct Protocol, you can control the paper cutter 
using the commands CUT, CUT ON, and CUT OFF. For help, see the Fingerprint 
Command Reference Manual.

Media Roll Retainer
Use the media roll retainer with a rotating media supply hub to keep large media 
rolls in place.

76 mm (3-in) Adapter
Use the 76 mm (3-in) adapter with a rotating media supply hub to use media rolls 
with 76 mm (3-in) inner diameter cores. The adapter cannot be used with a media 
supply roll post.

Internal Fanfold Guides
Use the internal fanfold guides to facilitate loading media from an external supply. 
The internal fanfold guide cannot be used in peel-off (self-strip) mode or with the 
label slack absorber.

Label Taken Sensor
The label taken sensor (LTS) is a photoelectric sensor that enables the printer’s 
firmware to detect if the last printed label, ticket, tag, etc. has been removed before 
printing another copy. The LTS cannot be used with a paper cutter.

If you are running Fingerprint or Direct Protocol, you can enable or disable the LTS 
using the commands LTS& ON and LTS& OFF. For help, see the Fingerprint Com-
mand Reference Manual.

Real Time Clock
The Real Time Clock (RTC) automatically keeps track of the current time. The RTC 
has its own backup battery backup that lasts for at least 10 years.

CompactFlash Protection Plate
The protection plate provides extra security by covering a CompactFlash card 
inserted in the back of the printer. 

Interface Boards
A number of interface boards are available for use with the printer. The interface 
boards are either installed at the factory or can easily be installed by an authorized 
service technician.

The printer can accommodate these interface boards:

• 802.11 Radio Interface Board

• Parallel Interface Board (IEEE 1284)

• Double Serial Interface Board
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• Serial/Industrial Interface Board

• RFID/Serial Interface Board
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PX4i and PX6i Hi
DEFAULT SETTINGS
Default Configuration
The following tables list the default values of the configuration commands sup-
ported on the printer. If you restore the printer to factory default settings, the 
printer uses these values.

The commands are grouped by function and reflect the organization of the IPL and 
Fingerprint setup menus. For detailed information on most of the commands, see 
the Fingerprint Command Reference Manual or the IPL Command Reference Man-
ual. 

Fingerprint Default Configuration

Ser-Com “uart1:” Parameters

Parameter Default Value

Baud rate 9600

Character length 8

Parity None

Stop bits 1

Flow control
RTS/CTS
ENQ/ACK
XON/XOFF; data to host
XON/XOFF; data from host

Disable
Disable
Disable
Disable

New line CR/LF

Receive buffer 1024 bytes

Transmit butter 1024 bytes
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Net-Com “net1:” Parameters

COM Parameters

Network Parameters

RFID Parameters

Feedadjust Parameters

Parameter Default Value

New line CR/LF

Parameter Default Value

USB keyboard US

Parameter Default Value

IP selection DHCP+BOOTP

IP address N/A

Netmask N/A

Default router N/A

IPv6 selection Auto

IPv6 address N/A

Nameserver N/A

Nameserver6 N/A

DHCP response Broadcast

MAC address N/A

Network type Ethernet (if no 802.11 radio is installed)
Wireless 802.11 (if an 802.11 radio is 
installed)

Parameter Default Value

Mode Enable

Tagadjust +0%

Retries 1

Voidtext N/A

Fieldstrength 100

Parameter Default Value

Startadjust 0

Stopadjust 0
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Media Parameters

Print Defines Parameters

Parameter Default Value

X-start
8 dots/mm = 203.2 dpi
11.81 dots/mm = 300 dpi

24 dots
36 dots

Width
8 dots/mm = 203.2 dpi
11.81 dots/mm = 300 dpi

832 dots
1248 dots

Length
8 dots/mm = 203.2 dpi
11.81 dots/mm = 300 dpi

1200 dots
1800 dots

Media type Label (with gaps)

Paper type Thermal transfer

Ribbon constant 90

Ribbon factor 25

Label offset 0

Ribbon sensor 14

Low diameter (ribbon) 0 dots

Label constant 85

Label factor 40

Contrast +0%

Paper sensor 10

Low diameter (paper) 0 dots

Testfeed N/A

Testfeed mode Fast

Len (slow mode) 0

Parameter Default Value

Head resistance N/A

Testprint N/A

Print speed 100 mm/sec

LSS test N/A

Clip default Off

Cmd language N/A

Label taken sensor (LTS)
LTS adjust
LTS test
LTS value

N/A
N/A
10
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IPL Default Configuration
Ser-Com Parameters

COM Parameters

Network Parameters

RFID Parameters

Parameter Default Value

Baud rate 9600

Data bits 8

Parity None

Stop bits 1

Protocol XON/XOFF

Parameter Default Value

USB keyboard US

Parameter Default Value

IP selection DHCP+BOOTP

IP address N/A

Netmask N/A

Default router N/A

IPv6 selection Auto

IPv6 address N/A

Nameserver N/A

Nameserver6 N/A

DHCP response Broadcast

MAC address N/A

Network type Ethernet (if no 802.11 radio is installed)
Wireless 802.11 (if an 802.11 radio is 
installed)

Parameter Default Value

Mode Enable

Tagread N/A

Tagadjust +0%

Retries 1

Voidtext N/A

Fieldstrength 100
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Test/Service Parameters

Media Parameters

Configuration Parameters

Parameter Default Value

Testprint
Config
Test labels
Format
Page
UDC
Font

N/A

Data dump No

Memory reset All

LSS test N/A

Cmd language N/A

Parameter Default Value

Media type Gap

Paper type DT (Direct Thermal)

LBL length dots 1200 dots

Testfeed mode Fast

Sensitivity 420

Darkness 0%

LBL rest point 0 

Form adj dots X 0 

Form adj dots Y 0 

Ribbon low 0

Paper low 0

Parameter Default Value

Emulation mode None

Print speed 4 in/sec

Cutter Not installed

LTS calibration Not installed
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APPENDIX

C

PX4i and PX6i Hi
SETUP MENUS
The setup parameters of the printer control the way the printer operates. This 
appendix provides an overview of the setup menu you can use to configure param-
eters for your printer.

Fingerprint Setup Menus
Use this section to learn about the Fingerprint setup menus and options.

Fingerprint Main Level Setup Menu

Fingerprint Ser-Com,UART1 Menu

SETUP:
SER-COM,UART1

SETUP:
NET-COM,NET1

SETUP:
COM

SETUP:
NETWORK

SETUP:
RFID

SETUP:
FEEDADJ

SETUP:
MEDIA

SETUP:
PRINT DEFS

XON/XOFF:
DATA FROM HOST

PARITY:
SPACE

BAUDRATE:
38400

FLOWCONTROL:
XON/XOFF

FLOWCONTROL:
ENQ/ACK

BAUDRATE:
19200

BAUDRATE:
9600

BAUDRATE:
4800

BAUDRATE:
2400

BAUDRATE:
1200

BAUDRATE:
600

BAUDRATE:
300

PARITY:
MARK

PARITY:
ODD

PARITY:
EVEN

CHAR LENGTH
7

STOP BITS:
2

SETUP:
SER-COM,UART1

SER-COM,UART1:
BAUDRATE

SER-COM,UART1:
CHAR LENGTH

SER-COM,UART1:
PARITY

SER-COM,UART1:
STOPBITS

SER-COM,UART1:
FLOWCONTROL

BAUDRATE:
115200

CHAR LENGTH:
8

PARITY:
NONE

STOP BITS:
1

FLOWCONTROL:
RTS/CTS

NEW LINE:
CR

NEW LINE:
LF

SER-COM,UART1:
NEW LINE

SER-COM,UART1:
REC BUF

SER-COM,UART1:
TRANS BUF

NEW LINE:
CR/LF

REC BUF:
10000

TRANS BUF:
1024

XON/XOFF:
DATA TO HOST
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Fingerprint Net-Com,NET1 Menu

Fingerprint COM Menu

Fingerprint Network Menu

Fingerprint RFID Menu

Fingerprint Feedadj Menu

SETUP:
NET-COM,NET1

NEW LINE:
CR

NEW LINE:
LF

NET-COM,NET1:
NEW LINE

NEW LINE:
CR/LF

USB KEYBOARD:
USER DEFINED

USB KEYBOARD:
GERMAN

USB KEYBOARD:
FRENCH

USB KEYBOARD:
SWEDISH

SETUP:
COM

COM:
USB KEYBOARD

USB KEYBOARD:
US

NETWORK TYPE:
Wireless 802.11

DHCP RESPONSE:
UNICAST

IPV6 SELECTION:
MANUAL

IPV6 SELECTION:
DHCP

IPV6 SELECTION:
AUTO+DHCP

PARITY:
BOOTP

PARITY:
DHCP

SETUP:
NETWORK

NETWORK:
IP SELECTION

NETWORK:
IP ADDRESS

NETWORK:
NETMASK

NETWORK:
DEFAULT ROUTER

NETWORK:
IPV6 SELECTION

PARITY:
MANUAL

IP SELECTION:
DHCP+BOOTP

IP ADDRESS:
0.0.0.0

NETMASK:
0.0.0.0

DEFAULT ROUTER:
0.0.0.0

IPV6 SELECTION:
AUTO

NETWORK:
IPV6 ADDRESS

IPV6 ADDRESS:
0000::000:0000:0

NETWORK:
NAMESERVER

NETWORK:
NAMESERVER6

NETWORK:
DHCP RESPONSE

NETWORK:
MAC ADDRESS

NETWORK:
NETWORK TYPE

NAMESERVER:
0.0.0.0

NAMESERVER6:
00::0

DHCP RESPONSE:
BROADCAST

MAC ADDRESS:
nnnnnnnnnnnn

NETWORK TYPE:
Ethernet

Read-only

MODE:
DISABLE

SETUP:
RFID

RFID:
MODE

RFID:
TAGADJUST

RFID:
RETRIES

RFID:
VOIDTEXT

MODE:
ENABLE

TAGADJUST:
+0

RETRIES:
1

VOIDTEXT:
VOID

RFID:
FIELDSTRENGTH

FIELDSTRENGTH:
72

These menus are only displayed when the optional RFID module is installed.

Read-only

SETUP:
FEEDADJ

FEEDADJ:
STARTADJ

FEEDADJ:
STOPADJ

STARTADJ:
+0

STOPADJ:
+0
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Fingerprint Media Menu

Fingerprint Print Defs Menu

TRANSFER:
LOW DIAMETER

TRANSFER:
RIBBON SENSOR

TRANSFER:
LABEL OFFSET

TRANSFER:
RIBBON FACTOR

TRANSFER:
RIBBON CONSTANT

MEDIA TYPE:
TICKET (w MARK)

MEDIA TYPE:
LABEL (w GAPS)

MEDIA SIZE:
LENGTH

MEDIA SIZE:
WIDTH

SETUP:
MEDIA

MEDIA:
MEDIA SIZE

MEDIA SIZE:
XSTART

MEDIA:
MEDIA TYPE

MEDIA TYPE:
VAR LENGTH STRIP

MEDIA TYPE:
FIX LENGTH STRIP

MEDIA:
PAPER TYPE

PAPER TYPE:
TRANSFER

MEDIA:
CONTRAST

PAPER TYPE:
DIRECT THERMAL

DIRECT THERMAL:
LABEL FACTOR

DIRECT THERMAL:
LABEL CONSTANT

TESTFEED MODE:
SLOW

MEDIA:
LEN (SLOW MODE)

MEDIA:
TESTFEED

MEDIA:
TESTFEED MODE

TESTFEED MODE:
FAST

LENGTH:
1200

WIDTH:
832

XSTART:
24

LOW DIAMETER:
0

RIBBON SENSOR:
14

LABEL OFFSET:
0

RIBBON FACTOR:
25

RIBBON CONSTANT:
90

LABEL FACTOR:
40

LABEL CONSTANT:
85

CONTRAST:
+0%

TESTFEED:
26 28 0 10

MEDIA:
PAPER

PAPER:
LOW DIAMETER

PAPER:
PAPER SENSOR

LOW DIAMETER:
0

PAPER SENSOR:
10

Only displayed if a paper sensor is installed.

+0%/+2%/+4%/+6%
+8%/+10%/-10%/-8%
-6%/-4%/-2%/-0%

LEN (SLOW MODE):
0

Press E to perform a
testfeed. Values are
read-only.

CMD LANGUAGE:
DSim

CMD LANGUAGE:
ZSim

CMD LANGUAGE:
IPL

CLIP DEFAULT:
OFF

TESTPRINT:
NETWORK INFO

TESTPRINT:
RFID TEST LABEL

TESTPRINT:
HARDWARE INFO

TESTPRINT:
SETUP INFO

TESTPRINT:
BAR CODES #2

TESTPRINT:
BAR CODES #1

TESTPRINT:
CHESS

PRINT DEFS:
TESTPRINT

LTS:
LTS ADJUST

LTS:
LTS TEST

LTS:
LTS VALUE

LTS VALUE:
10

TESTPRINT:
DIAMONDS

PRINT DEFS:
PRINT SPEED

PRINT DEFS:
LSS TEST

PRINT SPEED:
100

LSS TEST:
LSS MANUAL

LSS  [G: 1]D: 13
    �

REMOVE LABEL
ENTER TO STOP

REMOVE LABEL AND
PRESS ENTER

SETUP:
PRINT DEFS

PRINT DEFS:
HEAD RESIST

HEAD RESIST:
nnn

LSS TEST:
LSS AUTO

LSS AUTO:
    �

Toggle between 
gain (G) and drive (D)

Decrease or increase
value in brackets

PRINT DEFS:
LTS

SENSITIVITY 10
OUT OF 9-10

PRINT DEFS:
CMD LANGUAGE

PRINT DEFS:
CLIP DEFAULT

CLIP DEFAULT:
ON CMD LANGUAGE:

Direct Protocol

CMD LANGUAGE:
Fingerprint

Only displayed if a paper sensor is installed.
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IPL Setup Menus
Use this section to learn about the IPL setup menus and options.

IPL Main Level Setup Menu

IPL Ser-Com Menu

IPL COM Menu

IPL Network Menu

SETUP:
SER-COM

SETUP:
COM

SETUP:
NETWORK

SETUP:
RFID

SETUP:
TEST/SERVICE

SETUP:
MEDIA

SETUP:
CONFIGURATION

PROTOCOL:
STANDARD

PROTOCOL:
XON/XOFF+STATUS

BAUDRATE:
4800

BAUDRATE:
2400

BAUDRATE:
1200

BAUDRATE:
115200

BAUDRATE:
57600

BAUDRATE:
38400

BAUDRATE:
19200

PARITY:
SPACE

PARITY:
ODD

PARITY:
EVEN

CHAR LENGTH
7

STOP BITS:
2

SETUP:
SER-COM

SER-COM:
BAUDRATE

SER-COM:
DATA BITS

SER-COM:
PARITY

SER-COM:
STOP BITS

SER-COM:
PROTOCOL

BAUDRATE:
9600

DATA BITS:
8

PARITY:
NONE

STOP BITS:
1

PROTOCOL:
XON XOFF

USB KEYBOARD:
USER DEFINED

USB KEYBOARD:
GERMAN

USB KEYBOARD:
FRENCH

USB KEYBOARD:
SWEDISH

SETUP:
COM

COM:
USB KEYBOARD

USB KEYBOARD:
US

NETWORK TYPE:
Wireless 802.11

DHCP RESPONSE:
UNICAST

IPV6 SELECTION:
MANUAL

IPV6 SELECTION:
DHCP

IPV6 SELECTION:
AUTO+DHCP

PARITY:
BOOTP

PARITY:
DHCP

PARITY:
MANUAL

SETUP:
NETWORK

NETWORK:
IP SELECTION

NETWORK:
IP ADDRESS

NETWORK:
NETMASK

NETWORK:
DEFAULT ROUTER

NETWORK:
IPV6 SELECTION

IP SELECTION:
DHCP+BOOTP

IP ADDRESS:
0.0.0.0

NETMASK:
0.0.0.0

DEFAULT ROUTER:
0.0.0.0

IPV6 SELECTION:
AUTO

NETWORK:
IPV6 ADDRESS

IPV6 ADDRESS:
0000::000:0000:0

NETWORK:
NAMESERVER

NETWORK:
NAMESERVER6

NETWORK:
DHCP RESPONSE

NETWORK:
MAC ADDRESS

NETWORK:
NETWORK TYPE

NAMESERVER:
0.0.0.0

NAMESERVER6:
00::0

DHCP RESPONSE:
BROADCAST

MAC ADDRESS:
nnnnnnnnnnnn

NETWORK TYPE:
Ethernet

Read_only
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IPL RFID Menu

IPL Test/Service Menu

IPL Media Menu

MODE:
DISABLE

SETUP:
RFID

RFID:
MODE

RFID:
TAGREAD

RFID:
TAGADJUST

RFID:
RETRIES

RFID:
VOIDTEXT

MODE:
ENABLE

TAGREAD: TAGADJUST:
+0

RETRIES:
1

VOIDTEXT:
VOID

RFID:
FIELDSTRENGTH

FIELDSTRENGTH:
100

Only displayed if an RFID module is installed.

Read-only Read-only

CMD LANGUAGE:
Direct Protocol

CMD LANGUAGE:
Fingerprint

TEST LABELS:
PRINT QUALITY

SETUP:
TEST/SERVICE

TEST/SERVICE:
TESTPRINT

TEST/SERVICE:
DATA DUMP

TEST/SERVICE:
MEMORY RESET

TEST/SERVICE:
LSS TEST

TEST/SERVICE:
CMD LANGUAGE

LSS TEST:
LSS AUTO

CONFIG:
NETWORK

TESTPRINT:
CONFIG

TESTPRINT:
TEST LABELS

TESTPRINT:
FORMAT

TESTPRINT:
PAGE

TESTPRINT:
UDC

CONFIG:
HW

CONFIG:
SW

TEST LABELS:
PITCH

FORMAT:
ALL

PAGE:
ALL

UDC:
ALL

TESTPRINT:
FONT

FONT:
ALL

ALL:
PRINT FORMATS

ALL:
PRINT PAGES

ALL:
PRINT UDCs

ALL:
PRINT UDFs

LSS AUTO:
    �

MEMORY RESET:
CONFIGURATION

MEMORY RESET:
ALLDATA DUMP:

YES

DATA DUMP:
NO

CMD LANGUAGE:
DSim

CMD LANGUAGE:
ZSim

CMD LANGUAGE:
IPL

LTS:
LTS ADJUST

LTS:
LTS TEST

LTS:
LTS VALUE

LTS VALUE:
10

REMOVE LABEL
ENTER TO STOP

REMOVE LABEL AND
PRESS ENTER

PRINT DEFS:
LTS Only displayed if a paper sensor is installed.

MEDIA TYPE:
CONTINUOUS

MEDIA TYPE:
MARK

SETUP:
MEDIA

MEDIA:
MEDIA TYPE

MEDIA TYPE:
GAP

MEDIA:
PAPER TYPE

PAPER TYPE:
TTR

PAPER TYPE:
DT

MEDIA:
LBL LENGTH DOTS

LBL LENGTH DOTS:
1200

MEDIA:
LBL REST POINT

LBL REST POINT:
0

MEDIA:
FORM ADJ DOTS X

FORM ADJ DOTS X:
0

MEDIA:
FORM ADJ DOTS Y

FORM ADJ DOTS Y:
0

100/200/400/800/
1200/1600/2000/
2500/3000/3600/
4200/4800

0/2/4/6/8/10/15/20/25/
30/-30/-25/-20/-15/-10/
-8/-6/-4/-2

0/2/4/6/8/10/15/20/25/
30/-30/-25/-20/-15/-10/
-8/-6/-4/-2

0/2/4/6/8/10/15/20/25/
30/-30/-25/-20/-15/-10/
-8/-6/-4/-2

MEDIA:
RIBBON LOW

RIBBON LOW:
0

0/5/10/15/20/25/30/35/
40/45/50/55/60/65/70/
75/80

MEDIA:
PAPER LOW

PAPER LOW:
0

0/10/20/30/40/50/60/70/
80/90/100/110/120/130/
140/150

MEDIA:
TESTFEED MODE

TESTFEED MODE:
FAST

MEDIA:
SENSITIVITY

SENSITIVITY:
420

MEDIA:
DARKNESS

DARKNESS:
0

120/130/140/160/170/
180/222/226/236/238/
366/369/420/440/450/
460/470/480/513/527/
533/563/565/567/623/
627/633/647/673/677/
687/720/854/864

0/1/2/3/4/5/6/7/8/
9/10/-10/-9/-8/-7/
-6/-5/-4/-3/-2/-1
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IPL Configuration Menu

EMULATION MODE:
86XX-15MIL

PRINT SPPED:
4 IN/SEC

PRINT SPPED:
3 IN/SEC

PRINT SPPED:
2 IN/SEC

PRINT SPPED:
8 IN/SEC

PRINT SPPED:
7 IN/SEC

PRINT SPPED:
6 IN/SEC

SETUP:
CONFIGURATION

CONFIGURATION:
LTS CALIBRATION

LTS CALIBRATION:
PRESS <ENTER>

REMOVE LABEL AND
  PRESS ENTER

CONFIGURATION:
PWRUP EMULATION

CONFIG:
DISABLE

CONFIG:
ENABLE

CUTTER:
NOT INSTALLED

Labels are fed out

SENSITIVITY 9
OUT OF 8-14

Press E

Read only, 
press E

CONFIGURATION:
PRINT SPEED

PRINT SPEED:
5 IN/SEC

CONFIGURATION:
CUTTER

PWRUP EMULATION:
EMULATION MODE

EMULATION MODE:
86XX-10MIL

EMULATION MODE:
5MIL

EMULATION MODE:
NONE

EMULATION MODE:
86XX-15MIL

PRINT SPPED:
4 IN/SEC

PRINT SPPED:
3 IN/SEC

PRINT SPPED:
2 IN/SEC

PRINT SPPED:
8 IN/SEC

PRINT SPPED:
7 IN/SEC

PRINT SPPED:
6 IN/SEC

SETUP:
CONFIGURATION

CONFIGURATION:
LTS CALIBRATION

LTS CALIBRATION:
PRESS <ENTER>

REMOVE LABEL AND
  PRESS ENTER

CONFIGURATION:
PWRUP EMULATION

CONFIG:
DISABLE

CONFIG:
ENABLE

CUTTER:
NOT INSTALLED

Labels are fed out

SENSITIVITY 9
OUT OF 8-14

Press E

Read only, 
press E

CONFIGURATION:
PRINT SPEED

PRINT SPEED:
5 IN/SEC

CONFIGURATION:
CUTTER

PWRUP EMULATION:
EMULATION MODE

EMULATION MODE:
86XX-10MIL

EMULATION MODE:
5MIL

EMULATION MODE:
NONE
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APPENDIX

D

PX4i and PX6i Hi
ADVANCED CONFIGURATION
This appendix contains information on the printer file system and how to modify 
the appearance of the printer web page.

Printer File System (Fingerprint)
As you access the printer for communications, you encounter different parts of the 
printer file system. The following sections contain a device tree structure and brief 
descriptions of the different devices and directories of the file system.

Device Tree Structure
This illustration shows the device tree structure of the printer.

/ (root)

c

ADMIN

boot

tmp

rom

pffs

dev

card1

secure

images
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Devices and Directories
The file system of the printer is case-sensitive, which is important because file-
names in Fingerprint commands are translated into capital letters by default. 
Directories or files with lowercase names are inaccessible for Fingerprint com-
mands and programs.

The commands you use depend on how you navigate the printer file system:

• If you are accessing the printer through an FTP client or a web browser, you can 
easily navigate through the different devices and directories. Lowercase letters 
are not an issue for FTP or a web browser.

• If you are accessing the printer through raw TCP (“net1:”), you use Fingerprint to 
communicate with the printer. Because Fingerprint commands are translated 
into uppercase letters, you are restricted from accessing devices and directories 
with lowercase names. For more information on using Fingerprint, see the 
Fingerprint Command Reference Manual.

/(root)
The root node is write protected to preserve the device and file structure of the 
printer.

/c (or c:)
/c is the user file system. You can create directories here to store files such as pro-
grams, fonts, and images.

/c/ADMIN (or c:ADMIN)
This directory is only accessible for the admin user. It contains start order, Finger-
print restrictions, and other configuration parameters only configurable for an 
administrator.

/c/boot (or c:boot)
This directory contains the firmware, password file, and other system information.

/card1 (or card1:)
This directory is the CompactFlash (CF) card file system used to store files such as 
large fonts and images. You can also use the CF card to upgrade printer firmware.

/dev
This directory contains devices used for input/output, such as uart1, Flash, net1, 
parallel IEEE 1284. 
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/pffs (or pffs:)
The power fail file system is used to store files that need to be saved when the 
printer is turned off. Files stored in this location cannot exceed 256 bytes each. The 
total size of the “pffs” unit is 32 KB.

/rom (or rom:)
This device is used to store a collection of files that are available by default in the 
printer, for example the default web pages, fonts, and images.

/rom/images (or rom:images)
This directory is used to store images used for the default web pages.

/rom/secure (or rom:secure)
This directory is used to store the password protected web pages.

/tmp (or tmp:)
This is the printer’s temporary read/write memory. Files in this location are not 
saved when the power is turned off or if there is a power failure. Do not store valu-
able data in this location. You may want to use “tmp:” instead of “/c” to temporarily 
store data, because data can be written to SDRAM faster than to the flash memory.

Customizing the Printer Home Page
The easiest way to modify the appearance of the printer web page is to create an 
HTML file called “INDEX.HTM” on the device “/c” with custom designed logo and 
colors. From this file you can easily link to the printer configuration pages. The web 
server generates these web pages with dynamic information on the fly. This pro-
cess makes the real-time generated pages of the printer appear in the Honeywell 
style. The colors and logo of the customer are ignored. 

Web Style Guide Files
The printer network cards customizes the default web pages by changing the con-
figuration of the engine that generates the pages. While generating the pages, the 
web server accesses configuration parameters, like the background color, the 
name of logos to display on the page and generates the HTML code. Default con-
figuration of these parameters makes the printer’s web page appear in the Honey-
well style, with corporate colors and logos. When changing the parameters, the web 
pages are permanently customized.

Customization of these parameters has to be done in specific files called “Web 
Style Guide Files”, assigning user-defined values to several support environment 
variables. 
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Web style guide files contain parameters to set web page content and layout. These 
files can be stored either on /c or pffs:. 

In the file system, /c has priority over pffs:, which implies that if there is a web style 
guide on /c (for example /c/webstyleguide.0), the printer will not look for pffs:web-
styleguide.1. Store web style guides on pffs to minimize the risk of them being acci-
dentally removed.

Content of a Web Style Guide File
A Web Style Guide file has to contain a set of mandatory environment variables and 
it can also contain optional variables. All variables have to be lowercase, followed 
by a “=” sign and a consistent value. There is no specific order of the variables.

Required Environment Variables
Use the reference table below to understand all of the required environment vari-
ables.

Optional Environment Variables
The optional environment variables are used to specify extra parameters; for 
instance, these variables permit to change the printer’s model name. The web 
server only recognizes the following model names:

• PF2i

• PF4i

• PM4i

• PX4i

• PX6i

Variable Description

bgco Background color, BGCOLOR attribute of BODY tag.

coli Copyright link, link to html file showing Copyright notes.

cona Company name.

loat Logotype attributes, contains all attributes for the IMG-tag 
to replace the logo.

trna Trade name.
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The web server checks the available hardware and then displays the correct model 
name in the web page. If the page has to show a different name of the printer, the 
web style guide file has to contain the optional variable printer=your name.

x-www-url-Encoding Syntax Rules
The value given to environment variables has to be specified respecting the x-
www-url-encoding syntax rules. According to the syntax rules, characters can be 
inserted using the notation %<ASCII Hex>. For example, space in the ASCII table 
has the Hex number 20 so it corresponds to %20. 

Colors are specified according to the RGB syntax: %23cdcdcd corresponds to 
#cdcdcd.

Any quotation marks (%22) must be preceded by a back slash (\). 

The file must contain only one line, where the different variables and valuers are 
separated by ampersand (&) characters.

Memory and Storage
Web Style Guide files are designed to be placed on the printer’s pffs, as mentioned. 
Due to the memory limits of the pffs the environment variables have very short 
name (4 bytes), which may make them less user friendly to use, but this allows 
more space to be used for the value of the variable. 

Variable Description Comments

alco Active link color, ALINK attribute of BODY 
tag.

BGLI Background image link, BACKGROUND 
attribute of BODY tag.

heon Help on, enables a help link on the page. If this parameter is in the webstyle guide 
file, the variables “heli” and “hena” must 
have a value.

heli Help link, link associated to the Help tag.

hena Help link name, the label to be shown on 
the web page.

lico Link color, LINK attribute of BODY tag.

suon Support link on, enables a support link on 
the page.

If this parameter is in the webstyle guide 
file, then the variables “suli” and “suna” 
must have a value.

suli Support link, this is the link associated 
withe the support tag.

suna Support link name, this is the label to be 
shown on the web page.

teco Text color, TEXT attribute of the BODY 
tag.

vlco Visited link color.
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There is also a size limit per file that is set to 256 bytes. In case the Web Style Guide 
File you want to create is bigger than 256 bytes, the content has to be split in more 
than one file.

The parser daemon will start looking for the first Web Style Guide File which has to 
be named “webstyleguide.0”, then it will try to read the next file called “webstyle-
guide.1” and so on.

Creating a Web Style Guide File
You can create Web Style Guide Files with a standard text editor and then transfer 
them to the printer. Follow these rules when creating a Web Style Guide File:

• The name has to be lowercase.

• The first file has to have extension “.0”. The following files have to have 
sequential extension number if one number is missing in the sequence the 
parser will stop reading the files.

• The split point between one web style guide and the other cannot be in the 
middle of a line. The last line of the file has to be consistent in the syntax and the 
first line of the following web style guide file has to be a new line.

• If variables are specified more than one time, the last value is the one assumed.

Use the FTP server to transfer the files.

Example: The default Web Style Guide:
bgco=%23ffffff&loat=src%3d\%22/rom/images/
itclogo1.gif\%22+align%3dbottom+alt%3d\%22Honeywell\ 
%22+border%3d0&cona=Honeywell&coli=copyright.htmf&suli=support.h
tmf&suna=Support&suon=t&trna=EasyCoder
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